MOTU 896HD™
User’s Guide for Macintosh
SAFETY PRECAUTIONS AND ELECTRICAL REQUIREMENTS

WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRICAL SHOCK, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR OTHER MOISTURE.

CAUTION: TO REDUCE THE RISK OF ELECTRICAL SHOCK, DO NOT REMOVE COVER. NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

WARNING: DO NOT PERMIT FINGERS TO TOUCH THE TERMINALS OF PLUGS WHEN INSTALLING OR REMOVING THE PLUG TO OR FROM THE OUTLET.

WARNING: IF NOT PROPERLY GROUNDED THE MOTU 896HD COULD CAUSE AN ELECTRICAL SHOCK.

The MOTU 896HD is equipped with a three-conductor cord and grounding type plug which has a grounding prong, approved by Underwriters' Laboratories and the Canadian Standards Association. This plug requires a mating three-conductor grounded type outlet as shown in Figure A below.

If the outlet you are planning to use for the MOTU 896HD is of the two prong type, DO NOT REMOVE OR ALTER THE GROUNDING PRONG IN ANY MANNER. Use an adapter as shown below and always connect the grounding lug to a known ground. It is recommended that you have a qualified electrician replace the TWO prong outlet with a properly grounded THREE prong outlet. An adapter as illustrated below in Figure B is available for connecting plugs to two-prong receptacles.

Figure A

![3-prong plug](image1.png)

Grounding prong

Properly grounded 3-prong outlet

Figure B

![3-prong plug](image2.png)

Grounding lug

Screw

Adapter

Make sure this is connected to a known ground.

Two-prong receptacle

WARNING: THE GREEN GROUNDING LUG EXTENDING FROM THE ADAPTER MUST BE CONNECTED TO A PERMANENT GROUND SUCH AS TO A PROPERLY GROUNDED OUTLET BOX. NOT ALL OUTLET BOXES ARE PROPERLY GROUNDED.

If you are not sure that your outlet box is properly grounded, have it checked by a qualified electrician. NOTE: The adapter illustrated is for use only if you already have a properly grounded two-prong receptacle. Adapter is not allowed in Canada by the Canadian Electrical Code. Use only three wire extension cords which have three-prong grounding type plugs and three-prong receptacles which will accept the MOTU 896HD plug.

IMPORTANT SAFEGUARDS

1. Read instructions - All the safety and operating instructions should be read before operating the MOTU 896HD.
2. Retain instructions - The safety instructions and owner's manual should be retained for future reference.
3. Heed Warnings - All warnings on the MOTU 896HD and in the owner's manual should be adhered to.
4. Follow Instructions - All operating and use instructions should be followed.
5. Cleaning - Unplug the MOTU 896HD from the computer before cleaning and use a damp cloth. Do not use liquid or aerosol cleaners.
6. Overloading - Do not overload wall outlets and extension cords as this can result in a risk of fire or electrical shock.
7. Power Sources - This MOTU 896HD should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of power supply to your location, consult your local power company.
8. Power-Cord Protection - Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them. Pay particular attention to cords and plugs, convenience receptacles, and the point where they exit from the MOTU 896HD.
9. Lightning - For added protection for the MOTU 896HD during a lightning storm, unplug it from the wall outlet. This will prevent damage to the MOTU 896HD due to lightning and power line surges.
10. Servicing - Do not attempt to service this MOTU 896HD yourself as opening or removing covers will expose you to dangerous voltage and other hazards. Refer all servicing to qualified service personnel.
11. Damage Requiring Service - Unplug the MOTU 896HD from the computer and refer servicing to qualified service personnel under the following conditions.
   a. When the power supply cord or plug is damaged.
   b. If liquid has been spilled or objects have fallen into the MOTU 896HD.
   c. If the MOTU 896HD has been exposed to rain or water.
   d. If the MOTU 896HD does not operate normally by following the operating instructions in the owner's manual.
   e. If the MOTU 896HD has been dropped or the cabinet has been damaged.
   f. When the MOTU 896HD exhibits a distinct change in performance, this indicates a need for service.
12. Replacement Parts - When replacement parts are required, be sure the service technician has used replacement parts specified by the manufacturer or have the same characteristics as the original part. Unauthorized substitutions may result in fire, electric shock or other hazards.
13. Safety Check - Upon completion of any service or repairs to this MOTU 896HD, ask the service technician to perform safety checks to determine that the product is in safe operating conditions.

ENVIRONMENT

Operating Temperature: 10°C to 40°C (50°F to 104°F)

AVOID THE HAZARDS OF ELECTRICAL SHOCK AND FIRE

Do not handle the power cord with wet hands. Do not pull on the power cord when disconnecting it from an AC wall outlet. Grasp it by the plug.

INPUT

Line Voltage: 100 - 120 volts AC, RMS (US and Japan) or 220 - 250 volts AC, RMS (Europe). Frequency: 47 - 63 Hz single phase. Power: 7 watts maximum.

CAUTION: DANGER OF EXPLOSION IF BATTERY IS REPLACED. REPLACE ONLY WITH THE SAME OR EQUIVALENT TYPE RECOMMENDED BY MANUFACTURER. DISPOSE OF USED BATTERY ACCORDING TO MANUFACTURER'S INSTRUCTIONS.
Contents

5 Quick Reference: 896HD Front Panel
6 Quick Reference: 896HD Rear Panel
7 Quick Reference: MOTU FireWire Audio Console
9 About the 896HD
13 Packing List and Macintosh System Requirements
15 Installing the 896HD Hardware
33 Installing the 896HD Macintosh Software
37 MOTU FireWire Audio Console (Mac OS X)
45 MOTU FireWire Control Panel (Mac OS 9)
53 Digital Performer
61 AudioDesk
69 Other Mac OS X Audio Software
75 Cubase, Nuendo and OS 9 ASIO Software
85 Reducing Monitoring Latency
93 CueMix Console
101 Troubleshooting
About the Mark of the Unicorn License Agreement and
Limited Warranty on Software

TO PERSONS WHO PURCHASE OR USE THIS PRODUCT, carefully read all the
terms and conditions of the “click-wrap” license agreement presented to you when
you install the software. Using the software or this documentation indicates your
acceptance of the terms and conditions of that license agreement.

Mark of the Unicorn, Inc. (“MOTU”) owns both this program and its documentation.
Both the program and the documentation are protected under applicable copyright,
trademark, and trade-secret laws. Your right to use the program and the
documentation are limited to the terms and conditions described in the license
agreement.

Reminder of the terms of your license

This summary is not your license agreement, just a reminder of its terms. The actual
license can be read and printed by running the installation program for the software.
That license agreement is a contract, and clicking “Accept” binds you and MOTU to
all its terms and conditions. In the event anything contained in this summary is
incomplete or in conflict with the actual click-wrap license agreement, the terms of
the click-wrap agreement prevail.

YOU MAY: (a) use the enclosed program on a single computer; (b) physically transfer the
program from one computer to another provided that the program is used on only
one computer at a time and that you remove any copies of the program from the
computer from which the program is being transferred; (c) make copies of the
program solely for backup purposes. You must reproduce and include the copyright
notice on a label on any backup copy.

YOU MAY NOT: (a) distribute copies of the program or the documentation to others;
(b) rent, lease or grant sublicenses or other rights to the program; (c) provide use of the
program in a computer service business, network, time-sharing, multiple CPU or
multiple user arrangement without the prior written consent of MOTU; (d) translate,
adapt, reverse engineer, decompile, disassemble, or otherwise alter the program or
related documentation without the prior written consent of MOTU.

MOTU warrants to the original licensee that the disk(s) on which the program is
recorded be free from defects in materials and workmanship under normal use for a
period of ninety (90) days from the date of purchase as evidenced by a copy of your
receipt. If failure of the disk has resulted from accident, abuse or misapplication of the
product, then MOTU shall have no responsibility to replace the disk(s) under this
Limited Warranty.

This LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF:
AND YOU HEREBY WAIVE, ANY AND ALL OTHER WARRANTIES, BOTH
EXPLICIT AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE
LIABILITY OF MOTU PURSUANT TO THIS LIMITED WARRANTY SHALL BE
LIMITED TO THE REPLACEMENT OF THE DEFECTIVE DISK(S), AND IN NO
EVENT SHALL MOTU OR ITS SUPPLIERS, LICENSORS, OR AFFILIATES BE
LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING
BUT NOT LIMITED TO LOSS OF USE, LOSS OF PROFITS, LOSS OF DATA OR
DATA BEING RENDERED INACCURATE, OR LOSSES SUSTAINED BY THIRD
PARTIES EVEN IF MOTU HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS
WHICH MAY VARY FROM STATE TO STATE. SOME STATES DO NOT ALLOW
THE LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL
DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Update Policy

In order to be eligible to obtain updates of the program, you must complete and return
the attached Mark of the Unicorn Purchaser Registration Card to MOTU.

Copyright Notice

Copyright © 2003 by Mark of the Unicorn, Inc. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, stored in a retrieval system,
translated into any human or computer language, in any form or by any means
whichever, without express written permission of Mark of the Unicorn, Inc., 1280
Massachusetts Avenue, Cambridge, MA 02138, U.S.A.

Limited Warranty on Hardware

Mark of the Unicorn, Inc. and S&S Research (“MOTUS&S”) warrant this equipment
against defects in materials and workmanship for a period of NINETY (90) DAYS
from the date of original retail purchase. This warranty applies only to hardware
products; MOTU software is licensed and warranted pursuant to separate written
documents.

If you discover a defect, first write or call Mark of the Unicorn at (617) 576-2780 to
obtain a Return Merchandise Authorization Number. No service will be performed
on any product returned without prior authorization. MOTU will, at its option, repair or
replace the product at no charge to you, provided you return it during the warranty
period, with transportation charges prepaid, to Mark of the Unicorn, Inc., 1280
Massachusetts Avenue, MA 02138. You must use the product’s original packing
material for shipment, and insure the shipment for the value of the product. Please
include your name, address, telephone number, a description of the problem, and
the original, dated bill of sale with the returned unit and print the Return Merchandise
Authorization Number on the outside of the box below the shipping address.

This warranty does not apply if the equipment has been damaged by accident,
abuse, misuse, or misapplication; has been modified without the written permission
of MOTU, or if the product serial number has been removed or defaced.

ALL IMPLIED WARRANTIES, INCLUDING IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF
THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE
AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED.
No MOTUS&S dealer, agent, or employee is authorized to make any modification,
extension, or addition to this warranty.

MOTUS&S ARE NOT RESPONSIBLE FOR SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES RESULTING FROM ANY BREACH OF
WARRANTY, OR UNDER ANY LEGAL THEORY, INCLUDING LOST PROFITS,
DOWNTIME, GOODWILL, DAMAGE OR REPLACEMENT OF EQUIPMENT
AND PROPERTY AND COST OF RECOVERING REPROGRAMMING, OR
REPRODUCING ANY PROGRAM OR DATA STORED IN OR USED WITH
MOTUS&S PRODUCTS.

Some states do not allow the exclusion or limitation of implied warranties or liability
for incidental or consequential damages, so the above limitation or exclusion may not
apply to you. This warranty gives you specific legal rights, and you may have other
rights which vary from state to state.

MOTU, AudioDesk, MOTU, Mark of the Unicorn and the unicorn silhouette logo are
trademarks of Mark of the Unicorn, Inc.

This equipment has been type tested and found to comply with the limits for a class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with this instruction manual,
may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause interference to radio
or television equipment reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by any combination of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Plug the equipment into an outlet on a circuit different from that to which the receiver is connected.

If necessary, you can consult a dealer or experienced radio/television technician for additional
assistance.

PEASE NOTE: only equipment certified to comply with Class B (computer input/output devices,
terminals, printers, etc.) should be attached to this equipment, and must have shielded interface
cables in order to comply with the Class B FCC limits on RF emissions.

WARNING: changes or modifications to this unit not expressly approved by the party responsible
for compliance could void the user’s authority to operate the equipment.
Quick Reference: 896HD Front Panel

This is a standard quarter-inch stereo headphone jack. From the factory, it matches the signal going to the main outs. However, via software, you can program it to serve as its own independent output.

The MOTU 896HD provides four independent mix buses. Via the included GeoMix Console software, these four buses can be programmed to mix any combination of the 896HD's 18 inputs to any output pair of your choosing. The MONITOR LEVEL knob lets you control the volume of each mix from the front panel. Push the knob repeatedly to cycle among the four different mixes (1, 2, 3 or 4). When you do so, the LED to the left which bank you are currently monitoring. These meters can also provide stereo output metering for the 896HD's on-board mix buses (by pressing the MONITOR LEVEL knob).

These 10-segment level meters are dedicated to the 896HD's eight analog inputs. The top red 'LED' lights up when the signal reaches full scale—for even just one sample—and remains illuminated until you clear it in the software. The second 'over' LED below only lights up momentarily so that you can continue to adjust level even after clipping has just occurred. These level meters can also show you the current volume setting for the 896HD's four on-board mix buses. To view the bus volume settings, push the MONITOR LEVEL knob.

This toggle switch provides phantom power for a condenser mic plugged into this input. Up is on.

These eight trim knobs provide gain adjustment within a range of about 42dB for each analog input (when the 3-way switch on the rear panel is set to either MIC or LINE). If the 3-way switch is set to +4/FIXED, the corresponding front-panel trim pots is bypassed. Because each input also has a microphone preamp, you can plug just about anything into them: a microphone, a guitar, a synth — you name it.

For a microphone or unamplified instrument pickup, set the rear-panel 3-way switch to MIC, plug in your mic (XLR or quarter-inch plug) flip on 48V phantom power (if necessary) and use the trim knob as needed to adjust the level.

For -10dB (unbalanced) inputs (like synths) or +4dB (balanced) signals, set the rear-panel 3-way switch to LINE and use the trim knob to adjust the level. You can use either an XLR or quarter-inch plug. Note: the complete trim range, from all the way down with the MIC setting to all the way up with the LINE setting is around 55dB total. The MIC setting provides a 40dB range (approximately -37dBu to +5dBu) and the LINE setting offers a 30dB range (approximately -16dBu to +15dBu) with some overlap between them.

If you have +4dB inputs for which you'd like to maintain unity gain (for levels up to +18dBu), set the rear-panel 3-way switch to +4/FIXED. You can use either an XLR or quarter-inch plug.

If the toggle switch is down, the volume knob affects the headphone out (and the main outs operate at a fixed volume). If the toggle switch is up, the volume knob controls the main outs and the headphone out. Analog input meters 7-8 display the current headphone (7) and main out (8) volume setting as you turn the volume knob. Push the volume knob to cycle through the various settings for the programmable meters (both the 8-channel bank and the stereo AES/EBU meters).
Quick Reference: 896HD Rear Panel

These AES/EBU connectors can handle any supported sample rate up to 96 kHz, and they are also equipped with a sample rate converter so you can input or output at a different rate than the 896HD. For details, see “Syncing AES/EBU devices” on page 26. At the 4x sample rates (176.4 and 192kHz), AES/EBU is disabled.

These two XLR jacks serve as the MOTU 896HD’s main analog outputs. You can connect them to a set of powered studio monitors and then control the volume from the front panel Volume knob. At the 4x sample rates (176.4 or 192kHz), these jacks always mirror the headphone output.

These eight analog inputs are Neutrik™ combo connectors that accept either an XLR plug or a quarter-inch plug. They have 24-bit, 64x oversampling converters. Each input is equipped with a 3-way input level switch with three settings:

- **LINE**: Use this setting for +4dB or -10dB inputs, such as synthesizers or consumer audio equipment. Adjust the input level as needed with the corresponding front panel Trim control and level meter for this input. This setting offers a trim range of around 30dB (approximately -16dBu to +15dBu).

- **+4 / FIXED**: Use this setting for +4 balanced inputs for which you do not wish to modify the gain. This position disengages the front panel trim knob. This setting also provides slightly more attenuation than the LINE setting, allowing levels up to +18dBu.

- **MIC**: This setting feeds the input signal (XLR or quarter-inch) to the built-in preamp for additional gain. Use it for any microphone or unamplified instrument pickup. Engage phantom power for condenser mics with the front-panel 48V switch (on is on). Use the corresponding front panel trim knob and level meter to adjust the input level as needed. This setting offers a trim range of around 40dB (approximately -37dBu to +6dBu).

The MOTU 896HD’s eight analog outputs are XLR connectors with +4 / -10 switchable output (600 Ohm impedance). They are equipped with 24-bit, 128x oversampling enhanced multibit A/D converters capable of 192kHz recording.

The 896HD power supply is switchable between 110V and 220V operation. It should already be set to the proper voltage for your country but you can check the setting and adjust it if necessary with the red switch just to the left of this power cord receptacle (on the side of the metal chassis).

These ADAT optical digital I/O connectors can be connected either to an ADAT or any ADAT-compatible “lightpipe” device (such as a digital mixer). ADAT optical supplies eight channels of 24-bit digital I/O at 44.1 or 48kHz. It carries 4 channels of 24-bit digital I/O at 88.2 or 96kHz. (it is disabled at the 4x sample rates.)

Use the word clock input and output for digital transfers with devices that cannot slave to the clock supplied by their digital I/O connection with the 896HD.

Use the word clock input and output for digital transfers with devices that cannot slave to the clock supplied by their digital I/O connection with the 896HD.

Connect the MOTU 896HD to the computer here using the standard 1394 FireWire cable provided with your MOTU 896HD. Use the extra FireWire port to daisy-chain up to four 896HD’s to a single FireWire bus. You can also connect a MOTU 828, FireWire hard drive or other FireWire device. For details, see “Connecting multiple MOTU FireWire interfaces” on page 31.

If you are using the MOTU 896HD with an ADAT, use this standard ADAT SYNC INPUT to connect the MOTU 896HD to the end of your ADAT sync chain. For example, if you have three ADATs, chain the ADATs in the usual fashion (SYNC OUT to SYNC IN, etc.), and then connect the last ADAT’s SYNC OUT to this SYNC IN. This connection allows you to make sample-accurate audio transfers between AudioDesk (or other sample-accurate software) and the ADAT. If you have a MOTU MIDI Timepiece AV or Digital Timepiece, make it the master of the ADAT SYNC chain so that you can control everything from AudioDesk (or your other MIDI Machine Control compatible software).

If you are using the MOTU 896HD with an ADAT, use this standard ADAT SYNC INPUT to connect the MOTU 896HD to the end of your ADAT sync chain. For example, if you have three ADATs, chain the ADATs in the usual fashion (SYNC OUT to SYNC IN, etc.), and then connect the last ADAT’s SYNC OUT to this SYNC IN. This connection allows you to make sample-accurate audio transfers between AudioDesk (or other sample-accurate software) and the ADAT. If you have a MOTU MIDI Timepiece AV or Digital Timepiece, make it the master of the ADAT sync chain so that you can control everything from AudioDesk (or your other MIDI Machine Control compatible software).
Quick Reference: MOTU FireWire Audio Console

Determines the clock source for your 896HD. If you're just using the 896HD by itself, choose Internal. Use the other settings to resolve the 896HD to other devices. You can also resolve the 896HD to another audio device (such as a PCI-424 system), or even the Mac's built-in audio. Doing so ensures that 896HD audio will not drift apart from the other device during long playback or recording passes.

Enables or disables the 896HD's ADAT optical I/O. Turning them off frees up FireWire bandwidth.


This menu lets you choose what you will hear from the headphone jack. To mirror the main outs, choose Main Outs. Or you can mirror any other output pair. To hear the phones as their own independent output, choose Phones.

If you are running the 896HD interface at a 2x or 4x sample rate (88.2 to 192kHz), this option appears at the bottom of the interface settings. It lets you choose a word clock output rate that either matches the global sample rate (e.g. 192kHz) or forces a word clock output rate of either 44.1 or 48kHz.

Click the tabs to access general MOTU FireWire interface settings or settings specific to the 896HD (or other connected interface.)

Choose the global sample rate for the system here.

Specifies the stereo input and output pair when the 896HD is chosen for Mac OS X audio I/O in the System Preferences. Note: see system requirements below.

Enables or disables the 896HD's ADAT optical I/O. Turning them off frees up FireWire bandwidth.


Lets you choose what to monitor with the 896HD's programmable front panel meters.

The Clip Hold Time controls how long the top-most red LED remains illuminated after clipping. Choose 'Infinite' if you want to be able to clear the LED from Digital Performer. The Peak Hold Time controls how long the highest illuminated LED remains lit before going dark.

Click the General tab to access these settings.

If you are running under Mac OS 9, and any of these settings are grayed out (not available), see "If 896HD settings are grayed out" on page 51.

If you have a foot switch connected to the 896HD, these settings let you map the foot switch to any computer keyboard key for both the up and down position. For details about how to set this up, see "Enable Pedal" on page 43.

Let's you edit the names of the 896HD inputs and outputs, as they appear in your host audio software. These names will only appear in programs that support Mac OS X's port naming features.

*NOTE: the Default Stereo Input/Output menus only appear with the following minimum system requirements:

- Mac OS X 10.2.7 is installed with QuickTime 6.4 or later, OR
- Mac OS X 10.3 (aka Panther) or later

In the standard Mac OS X fashion, the console appears in the dock when you launch it. If the Launch console automatically option is checked (as shown above), the icon appears as soon as you switch on your 896HD interface. If you click the optical I/O icon, a menu of hardware settings appears as shown to the right. You can view and configure any hardware settings from this menu, without opening the console window.
CHAPTER 1  About the 896HD

OVERVIEW
The 896HD is a computer-based hard disk recording system for Mac OS and Windows that provides 18 separate inputs and 22 separate outputs (at 44.1 or 48kHz), including separate main outs and headphone out. All inputs and outputs can be accessed simultaneously. The 896HD consists of a standard 19-inch, double-space, rack-mountable I/O unit that connects directly to a computer via a standard IEEE 1394 FireWire™ cable. The 896HD offers the following:

- Operation at 44.1, 48, 88.2, 96, 176.4 or 192 kHz
- Eight 24-bit analog outputs individually switchable between +4 and -10dB operation
- Eight 24-bit analog inputs equipped with Neutrik “combo” jacks and independent 3-way level switch for MIC, LINE or +4/FIXED inputs
- Eight-channel ADAT optical digital I/O
- AES/EBU with sample rate conversion
- Two extra analog main outs
- Eight mic preamps (one on each input)
- Independent 48V phantom power for each input
- Independent front-panel trim for each input
- Sample-accurate ADAT sync input
- Word clock input and output
- Two FireWire jacks for chaining multiple units
- Foot switch input for hands-free punch-in/out
- Front-panel Headphone jack
- Main volume knob (for headphone + main outs)
- CueMix™ DSP no-latency monitoring
- 10-segment LED level meters for each input
- 10-segment programmable LEDs for analog output, ADAT input or ADAT output
- 10-segment programmable LEDs for AES/EBU input or output
- Switchable power supply (110V or 220V)

With a variety of I/O formats, mic preamps, no-latency monitoring of live input and synchronization capabilities, the 896HD is a complete, portable “studio in a box” when used with a Macintosh or Windows computer. The 896HD system includes AudioDesk™, full-featured audio workstation software for Mac OS that supports both 16-bit and 24-bit recording. Also included is an ASIO driver for multi-channel operation with any Macintosh audio software that supports ASIO drivers.

THE 896HD I/O REAR PANEL
The 896HD rear panel has the following connectors:

- Eight 24-bit XLR analog outputs, each equipped with an independent 2-way output level switch (+4 or -10dB)
- Eight 24-bit Neutrik “combo” (XLR + balanced quarter-inch) analog inputs, each equipped with an independent 3-way level switch (MIC, LINE, +4/FIXED), mic preamp, front-panel 48V phantom power switch, and front-panel trim knob
- One set of ADAT optical ‘light pipe’ connectors (8 channels of ADAT optical input and output at 44.1/48kHz and 4 channels at 88.2/96kHz)
- AES/EBU input and output
Two XLR main analog outputs with volume knob (on the front panel)

One 9-pin ADAT SYNC IN connector

BNC word clock input and output

Two 1394 FireWire jacks

### 18 inputs and 22 outputs

All 896HD inputs and outputs can be used simultaneously, for a total of 18 inputs and 22 outputs at 44.1/48kHz:

<table>
<thead>
<tr>
<th>Connection</th>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>24-bit 192kHz XLR analog</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>24-bit 192kHz XLR main outputs</td>
<td>-</td>
<td>stereo</td>
</tr>
<tr>
<td>Headphone output</td>
<td>-</td>
<td>stereo</td>
</tr>
<tr>
<td>ADAT optical digital (at 44.1 or 48kHz)</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>AES/EBU 24-bit 96kHz digital</td>
<td>stereo</td>
<td>stereo</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>18</strong></td>
<td><strong>22</strong></td>
</tr>
</tbody>
</table>

All inputs and outputs are discrete. In other words, using the main outs does not “steal” an output pair from the bank of eight XLR analog outputs. The same is true for the headphone outs.

The ADAT optical ports provide 4 channels of I/O at 88.2 or 96kHz. They are disabled at the 4x sample rates (176.4 and 192kHz).

The headphone output can operate as an independent output pair, or it can mirror any other 896HD output pair, such as the main outs.

### Analog

All 10 analog inputs are equipped with 24-bit 192kHz, 64x oversampling A/D converters. All 12 analog outputs have 24-bit 128x oversampling D/A converters. All audio is carried to the computer in a 24-bit data stream. Each output can be individually switched between either +4 or -10dB operation. Each input can be individually set to one of three input levels: MIC (feeds the mic preamp and includes front-panel trim and switchable 48V phantom power), LINE (for -10dB inputs with front-panel trim) and +4/FIXED (for +4 “hot” inputs for which no gain adjustment in the 896HD is desired).

### Mic preamps

All eight analog inputs are equipped with a mic preamp on a Neutrik™ combo-style connector that accepts either an XLR or quarter-inch plug. Defeatable 48V phantom power is supplied by a front panel switch. In addition, each input has its own trim knob, which provides a trim range of approximately 40dB.

### Main Outs

The main outs are equipped with 24-bit 192kHz 128x oversampling D/A converters and serve as independent outputs for the computer or for the 896HD’s on-board CueMix DSP mixes. The main out volume can be controlled with the front panel volume knob (when the switch is in the Main Outs + Phones position).

### Optical

The 896HD optical jacks support the industry standard ADAT optical format, which provides eight channels of 24-bit digital audio at either 44.1 or 48 kHz, and four channels at 88.2 or 96kHz.

### AES/EBU with sample rate conversion

The 896HD rear panel provides a standard AES/EBU digital input and output that supports digital I/O at 44.1, 48, 88.2 and 96 kHz. In addition, input or output can be sample-rate converted to any of these sample rates in situations that call for a different rate than the 896HD’s global sample rate. The AES/EBU jacks are disabled at the 4x sample rates (176.4 and 192kHz).

### ADAT sync: sample-accurate synchronization

The 896HD’s standard 9-pin ADAT SYNC IN connector provides sample-accurate synchronization with all Alesis ADAT tape decks connected
to the system—or any device that supports the ADAT sync format. For example, if you digitally transfer a single track of material from an ADAT via light pipe into audio workstation software on the computer, and then transfer the track back to the ADAT, it will be recorded exactly at its original location, down to the sample.

**Word clock**
The 896HD provides standard word clock that can slave to any supported sample rate. In addition, word clock can resolve to and generate “high” and “low” sample rates. For example, if the 896HD global sample rate is set to 96 kHz, the word clock input can resolve to a “low” rate of 48 kHz. Similarly, when the 896HD is operating at 192 kHz, the MOTU FireWire Audio Console lets you choose a word clock output rate of 48 kHz (the **Force 44.1/48kHz** setting).

**Punch in/out**
The quarter-inch Punch in/out jack accepts a standard foot switch. When you push the foot switch, the 896HD triggers a programmable keystroke on the computer keyboard. For example, with MOTU’s Digital Performer audio sequencer software, the foot switch triggers the 3 key on the numeric keypad, which toggles recording in Digital Performer. Therefore, pressing the foot switch is the same as pressing the 3 key. The 896HD Control Panel software lets you program any keystroke you wish.

**1394 FireWire**
The two 1394 FireWire jacks accept a standard IEEE 1394 FireWire cable to connect the 896HD to a FireWire-equipped Macintosh or Windows computer. The second jack can be used to daisy chain multiple interfaces — up to four MOTU FireWire interfaces — on a single FireWire bus. It can also be used to connect other FireWire devices without the need for a FireWire hub.

---

**THE 896HD FRONT PANEL**

**Headphone output and main volume control**
The MOTU 896HD front panel includes a quarter-inch stereo headphone output jack and volume knob. From the factory, the headphone output matches the main stereo outs. An accompanying switch allows you to control the volume of the phones only (down) or both the phones and the main outs (up). The headphone output can also operate as its own independent output pair, or it can mirror any other 896HD output pair, such as the AES/EBU output. Use the MOTU FireWire Console to choose the desired headphone output.

**CueMix™ DSP no-latency monitoring**
The MOTU 896HD provides CueMix™ DSP no-latency monitoring, which can mix all inputs to any output pair. At samples rates up to 96kHz, four such mixes can be independently programmed and simultaneously operated. At the 4x sample rates (176.4 or 192kHz), two CueMix DSP mixes are supported.

**Input trim knobs and phantom power switch**
The front-panel input trim knobs provide independent trim for the eight analog inputs. The phantom power switch for each input provides 48V phantom power. Up is on; down is off.

**Metering**
The front panel of the MOTU 896HD displays two eight-channel banks of 10-segment ladder LEDs. The left-hand bank always shows the eight analog inputs. The right-hand bank shows one of three different banks, which you can specify in the MOTU FireWire Audio Console software: Analog out, ADAT input, or ADAT output. A status LED to the left shows which bank you are currently viewing. These two banks also provide metering for the four CueMix DSP monitor mixes (when the front-panel MONITOR LEVEL knob is pressed and/or turned).
The 896HD front panel also displays stereo meters for the main analog outs and AES/EBU. The AES/EBU meters can display either input or output as specified in the MOTU FireWire Audio Console software. A status LED to the right shows whether you are viewing input or output.

16-BIT AND 24-BIT RECORDING
The 896HD system handles all data with a 24-bit signal path, regardless of the I/O format. You can record and play back 16-bit or 24-bit audio files at any supported sample rate via any of the 896HD’s analog or digital inputs and outputs. 24-bit audio files can be recorded with any compatible host application that supports 24-bit recording.

AUDIODESK
AudioDesk is a full-featured, 24-bit audio workstation software package included with the 896HD system (for Mac OS 9 and Mac OS X only). AudioDesk provides multi-channel waveform editing, automated virtual mixing, graphic editing of ramp automation, real-time effects plug-ins with 32-bit floating point processing, crossfades, support for many third-party audio plug-ins, background processing of file-based operations, sample-accurate editing and placement of audio, and more.

DIGITAL PERFORMER
The 896HD system is fully integrated with MOTU’s award-winning Digital Performer audio sequencer software package.

OTHER HOST AUDIO SOFTWARE
The 896HD system includes a standard Mac OS X CoreAudio driver for multichannel I/O with any audio application that supports CoreAudio.

The 896HD also includes a Mac OS 9 Macintosh ASIO driver for multi-channel compatibility with any Mac OS 9 audio application that supports ASIO drivers.

A COMPUTER-BASED SYSTEM
Regardless of what software you use with the 896HD, the host computer determines the number of tracks the software can record and play simultaneously, as well as the amount of real-time effects processing you can apply to your mix. A faster computer with more RAM and faster hard drives will allow more simultaneous tracks and real-time effects than a slower computer with less RAM and slower hard drives. Today’s fastest computers can typically play as many as 72 tracks or more.
CHAPTER 2  Packing List and Macintosh System Requirements

PACKING LIST
The 896HD ships with the items listed below. If any of these items are not present in your 896HD box when you first open it, please immediately contact your dealer or MOTU.

■ One 896HD I/O rack unit
■ One 1394 “FireWire” cable
■ Power cord
■ One 896HD Mac/Windows manual
■ One AudioDesk OS 9/OS X “Flipbook” Manual
■ One cross-platform CD-ROM
■ Product registration card

PLEASE REGISTER TODAY!
Please send in the registration card included with your 896HD system. As a registered user, you will be eligible to receive on-line technical support email and announcements about product enhancements as soon as they become available. Only registered users receive these special update notices, so please, complete and mail this registration card!

There is also an AudioDesk software registration card found in your AudioDesk Mac OS 9/OS X “flipbook” manual (at the beginning of the OS X side of the manual). Please be sure to fill out and return this card as well, so that you will be eligible to receive on-line technical support, email and announcements about AudioDesk software enhancements as soon as they become available.

Thank you for taking the time to register your new MOTU products!

MACINTOSH SYSTEM REQUIREMENTS
The 896HD system requires the following Macintosh system:

■ A G3/300Mhz Power Macintosh or faster equipped with at least one FireWire port
■ At least 64MB (megabytes) of RAM (128MB or more is recommended)
■ Mac OS 9 or Mac OS X (version 10.2.7 or later)
■ For Mac OS 9 users only: FireWire Enabler and FireWire Support system extensions 2.4 or later
■ A large hard drive (preferably at least 20GB)
CHAPTER 3  Installing the 896HD Hardware

OVERVIEW
Here’s an overview for installing the 896HD:

Connect the 896HD interface ........................................ 15
Connect the 896HD to the computer.

Connect audio inputs and outputs ................. 16
Make optical and analog connections as desired.

Connect a foot switch ................................................. 17
Connect a footswitch to trigger any keystroke.

A typical 896HD setup (no mixer) ....................... 17
An example setup for computer-based mixing/FX.

Using the 896HD with a mixer ................................. 18
An example setup for a mixer-based studio.

Making sync connections ........................................... 19
If you need to resolve the 896HD with other
devices, make the necessary sync connections.

Do you need a synchronizer? ................................. 20
Sample-accurate sync ........................................ 21
Sample-accurate ADAT sync ................................. 22
Sample-accurate ADAT sync with no synchronizer ... 23
Syncing to video and/or SMPTE time code .......... 24
Syncing optical devices ........................................ 25
Syncing AES/EBU devices ................................... 26
Syncing word clock devices ............................... 29
Syncing large systems ........................................ 30
Connecting multiple MOTU FireWire interfaces .... 31

CONNECT THE 896HD INTERFACE
1  Plug one end of the 896HD FireWire cable
   (included) into the FireWire socket on the
   computer as shown below in Figure 3-1.

2  Plug the other end of the FireWire cable into the
   896HD I/O as shown below in Figure 3-1.
CONNEC T AUDIO INPUTS AND OUTPUTS
The 896HD audio interface has the following audio input and output connectors:

- 8 XLR analog outputs
- 8 Neutrik™ XLR/quarter-inch analog inputs
- 2 XLR main outs
- AES/EBU input/output
- ADAT optical input/output

Analog inputs
The 896HD analog inputs are Neutrik combo connectors that accept either a male XLR plug or a quarter-inch plug. You can use either type of plug, regardless of whether it is a mic, synth, or whatever. Set the 3-way input level switch as follows:

For a microphone or unamplified instrument pickup, set the rear-panel 3-way switch to MIC, plug in your mic (XLR or quarter-inch plug), flip on 48V phantom power (if necessary) and use the trim knob as needed to adjust the level.

For -10dB (unbalanced) inputs (like synths) or +4 (balanced) signals that may need to be boosted, set the rear panel 3-way switch to LINE and use the trim knob to adjust the level. You can use either an XLR or quarter-inch plug. (Note: the complete trim range, from all the way down with the MIC setting to all the way up with the LINE setting is around 55dB total. The MIC setting provides a 40dB range and the LINE setting offers a 30dB range with some overlap between them.)

If you have +4 inputs for which you’d like to maintain unity gain, set the 3-way switch to +4/FIXED. Use either an XLR or quarter-inch plug.

Analog outputs
Connect an XLR cable and set the desired output level with the 2-way level switch (+4 or -10dB).

ADAT optical
Use standard ADAT optical cables. Reminder: optical goes OUT to IN and IN to OUT, like MIDI.

AES/EBU
Connect standard AES/EBU input and output. 2x sample rates (88.2 & 96 kHz) are supported; 4x samples rates (176.4 or 192kHz) are not supported.

Main outs
When the 896HD is operating at any sample rate up to 96kHz, the main outputs serve as a separate, independent output pair. The main output volume can be controlled by the main volume knob on the front panel (when the switch is up). In a typical studio, the main outs are intended for a pair of monitors. However, if you are using the 896HD in other ways, such as in a live performance situation, you could use the main outs for stage monitors or for some other purpose.

Using an external mixer
The 896HD can be used with or without a mixer, as shown on the following pages. In Figure 3-3 (no mixer), all mixing and effects processing occurs in the audio software running on the computer. If you’d like to use external mixing, see “Using the 896HD with a mixer” on page 18.

Figure 3-2: the 896HD rear panel.
CONNECT A FOOT SWITCH
If you would like to use a foot switch with your 896HD, connect it to the PUNCH IN/OUT jack. See “Quick Reference: MOTU FireWire Audio Console” on page 7 for information about how to program the foot switch to trigger any computer keystroke you wish.

A TYPICAL 896HD SETUP (NO MIXER)
Here is a typical 896HD studio setup. This rig can be operated without an external mixer. All mixing and processing can be done in the computer with audio software. During recording, you can use the 896HD’s CueMix™ DSP no-latency monitoring to listen to what you are recording via the main outs, headphone outs, or any other output pair. You can control monitoring from the included CueMix Console software.

Figure 3-3: A typical 896HD studio setup.
USING THE 896HD WITH A MIXER
While there are many ways to use the 896HD with an external mixer, typically the 896HD serves as a multi-channel "pipeline" between the mixer and the computer. If your mixer is analog, connect the analog section of the 896HD to your mixer. If your mixer is digital, and it has ADAT optical I/O, you can connect them optically as shown below in Figure 3-4. Add more 896HD’s for additional banks of eight-channel I/O. The 896HD’s available analog and AES/EBU inputs and outputs can serve as an extension to the mixer I/O, but then you will probably find yourself mixing in two places: the mixer and the computer. A word of advice: if you would like to use the 896HD with an external mixer, use the mixer for mixing. Trying to mix large multitrack projects in two places can become very cumbersome very quickly.

Figure 3-4: Using the 896HD with a digital mixer.
MAKING SYNC CONNECTIONS
If you connect devices digitally to the 896HD, or if you need to synchronize the 896HD with an outside time reference such as SMPTE time code, you must pay careful attention to the synchronization connections and clock source issues discussed in the next few sections.

Do you need to synchronize the 896HD?
If you will be using only the 896HD’s analog inputs and outputs (and none of its digital I/O), and you have no plans to synchronize your 896HD system to SMPTE time code or other external clock source, you don’t need to make any sync connections. You can skip this section and proceed to chapter 4, “Installing the 896HD Macintosh Software” (page 33). After you install the 896HD software, you’ll open the MOTU FireWire Audio Console and set the Clock Source setting to Internal as shown below. For details, see chapter 5, “MOTU FireWire Audio Console (Mac OS X)” (page 37) or chapter 6, “MOTU FireWire Control Panel (Mac OS 9)” (page 45).

![Figure 3-5: You can run the 896HD under its own internal clock when it has no digital audio connections and you are not synchronizing the 896HD system to an external time reference such as SMPTE time code.](image)

Situations that require synchronization
There are three general cases in which you will need to resolve the 896HD with other devices:

- Synchronizing the 896HD with other digital audio devices so that their digital audio clocks are phase-locked (as shown in Figure 3-6)
- Slaving the 896HD system to SMPTE time code from a video deck, analog multi-track, etc.
- Both of the above

Synchronization is critical for clean digital I/O
Synchronization is critical in any audio system, but it is especially important when you are transferring audio between digital audio devices. Your success in using the 896HD’s digital I/O features depends almost entirely on proper synchronization. The following sections guide you through several recommended scenarios.

Be sure to choose a digital audio clock master
When you transfer digital audio between two devices, their audio clocks must be in phase with one another — or phase-locked. Otherwise, you’ll hear clicks, pops, and distortion in the audio — or perhaps no audio at all.

![Figure 3-6: When transferring audio, two devices must have phase-locked audio clocks to prevent clicks, pops or other artifacts.](image)

There are two ways to achieve phase lock: slave one device to the other, or slave both devices to a third master clock. If you have three or more digital audio devices, you need to slave them all to a single master audio clock.

![Figure 3-7: To keep the 896HD phased-locked with other digital audio devices connected to it, choose a clock master.](image)

Also remember that audio phase lock can be achieved independently of time code (location). For example, one device can be the time code master while another is the audio clock master. But only one device can be the audio clock master. If you set things up with this rule in mind, you’ll have trouble-free audio transfers with the 896HD.
DO YOU NEED A SYNCHRONIZER?
Whether or not you’ll need a synchronizer depends on your gear and what you will be doing with your 896HD system. The following pages give you specific information about common sync scenarios. At least one of them will likely apply to you. Here are some general considerations to help you determine if you need (or want) a synchronizer for your 896HD system.

You don’t need a synchronizer if...
As explained earlier, the 896HD’s digital audio clock must be phase-locked (synchronized) with other connected digital audio devices to achieve clean digital transfers between them. Can this be accomplished without an additional digital audio synchronizer? It depends on the nature of the other devices, and what you want to do with them. You don’t need a synchronizer if the device has a way of locking itself directly to the 896HD’s clock (via ADAT lightpipe, AES/EBU or word clock), AND if the device carries no sense of location in time. A digital mixer is a good example: it can slave to its ADAT lightpipe connection from the 896HD, and it has no sense of time; it just passes audio through for mixing.

A stand-alone digital recorder, on the other hand, does have a sense of location in time, either via SMPTE time code or via its own sample address. For example, if you want to fly tracks back and forth between your computer and an Alesis hard disk recorder while maintaining the audio’s position in time, the ADAT Sync port on the 896HD lets you do so without a separate synchronizer — and with sample-accurate precision, as long as you’re using AudioDesk, Digital Performer, or other sample-accurate software. Just connect the 896HD directly to the Alesis recorder (or other ADAT Sync-compatible device) as discussed in “Sample-accurate ADAT sync with no synchronizer” on page 23. But if you also want transport control over the entire rig (including the hard disk recorder) from your audio software, you’ll need a MIDI Machine Control-compatible synchronizer such as MOTU’s MIDI Timepiece AV, as discussed in “Sample-accurate sync” on page 21. If you are simply using a stand-alone recorder as a way to capture live tracks that you then transfer in one pass into the computer, no synchronizer is required because the tracks will remain in perfect phase lock with each other as you transfer them together. You can simply slave the stand-alone recorder to the optical output from the 896HD as explained in “Syncing optical devices” on page 25.

Transport control from your computer
If you have stand-alone digital recorders connected to the 896HD, and they support ADAT Sync, your audio software — if it supports MIDI Machine Control (MMC) — allows you to control the transports of everything from your computer. Most advanced audio programs support MMC. To do this, you’ll also need an MMC-compatible ADAT synchronizer such as a MOTU MIDI Timepiece AV or Digital Timepiece. Synchronizers like these allow you to play, stop, rewind and locate all of your tape decks using the transport controls in the audio software. If your audio software supports sample-accurate sync (like Digital Performer and AudioDesk), you can do so with sample-accurate precision. The following pages show you how to achieve MMC control, where possible.

Continuous sync to SMPTE / MTC
If you need to synchronize the 896HD (and your audio software) to SMPTE time code, this requires a dedicated synchronizer, which continuously resolves the 896HD to SMPTE time code, while simultaneously resolving your audio software to MIDI Time Code. When the 896HD is continuously resolved, audio playback will never drift with respect to the time code. Again, the MOTU MIDI Timepiece AV and Digital Timepiece are affordable examples of this type of
synchronizer. The following pages illustrate how to set up this type of synchronization with various kinds of gear. Regardless of the specific equipment you have, you can follow the basic connections shown.

**SAMPLE-ACCURATE SYNC**

Your 896HD system provides you with the most advanced, accurate synchronization possible with Alesis modular digital tape decks and hard disk recorders — or any device that supports sample-accurate ADAT sync. Figure 3-8 below shows a few best-case scenarios. Below is a brief explanation of the benefits you achieve with these setups.

Sample accurate locating

With *sample accurate locating*, when you transfer audio between AudioDesk (or any other sample-accurate host software) and a sample-accurate recorder, the audio will not drift in time — even by as little as one sample. This is the tightest possible synchronization between digital audio devices. The timing in your audio will not be affected in any way by the process of transferring it between the 896HD and the recorder.

Is your audio software sample-accurate?

Sample-accurate locating is only possible with software that supports this feature, such as AudioDesk or Digital Performer. For third-party software, sample-accurate performance (if it’s supported) is achieved through the 896HD’s ASIO Version 2 driver (Mac OS 9 only).

**Transport control from your computer**

If you have a MIDI Timepiece AV, Digital Timepiece or any ADAT synchronizer that also supports MIDI Machine Control (MMC), you can play, stop, rewind and locate all of your ADATs using the transport controls in the audio software running on your computer. This includes cueing features like markers, position bars, playback wipers, time rulers, etc.

<table>
<thead>
<tr>
<th>Sync format</th>
<th>Software</th>
<th>Synchronizer</th>
<th>Sample accurate locating</th>
<th>Transport control from computer</th>
<th>Continuous sync to SMPTE / MTC</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADAT</td>
<td>AudioDesk, Cubase or Digital Performer</td>
<td>MIDI Timepiece AV or Digital Timepiece</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ADAT</td>
<td>AudioDesk, Cubase or Digital Performer</td>
<td>BRC (or any MMC capable ADAT synchronizer)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ADAT</td>
<td>AudioDesk, Cubase or Digital Performer</td>
<td>None</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Figure 3-8: These recommended combinations of hardware and software offer the tightest sync possible between the 896HD and digital audio recorders in the form of sample-accurate locating between the software and the tape decks. Sample accurate locating is possible even without a MIDI Timepiece AV or Digital Timepiece, although you give up transport control from the computer.
SAMPLE-ACCURATE ADAT SYNC

The 896HD can achieve sample-accurate sync with ADATs, Alesis hard disk recorders or any ADAT Sync-compatible devices. Sample-accurate software is required, such as AudioDesk, Digital Performer, or Mac OS 9 ASIO 2.0-compatible software that also supports sample-accurate sync. Connect the 896HD to the end of the ADAT Sync chain and make the software settings shown below in Figure 3-10. If you will be using the stand-alone recorder for its analog inputs and outputs only (you won’t be doing any recording with it), treat it as an ‘optical’ device. See “Syncing optical devices” on page 25.

In AudioDesk or Digital Performer:
1. Choose Receive Sync in the Setup menu (Basics menu under OS 9).
2. Choose the Sample-accurate option shown to the left.
3. Make sure that Slave to External Sync is checked in the Studio menu (Basics menu under OS 9).

USB or serial cable (bi-directional MIDI connection) bearing MMC transport commands from AudioDesk or Digital Performer to the MIDI Timepiece AV (or other synchronizer).

If you have a MOTU synchronizer, set its sync mode to Internal.

In AudioDesk or Digital Performer, turn on MIDI Machine Control by pressing this button. This brings on line all the recorders connected to the DTP or MTP AV.

AudioDesk automatically scans the DTP or MTP AV for connected recorders, and they appear here.

Figure 3-10: Connections for sample-accurate ADAT sync.

To set the 896HD hardware clock source for sample-accurate sync:
1. In AudioDesk or Digital Performer, choose MOTU Audio System>Configure Hardware Driver from the Setup menu (or the Basics menu under OS 9), or run the MOTU FireWire Audio Console.
2. Choose ADAT 9-pin from the Clock Source menu as shown to the left.
3. Make sure that Sample Rate setting matches the recorder and synchronizer.

In AudioDesk or Digital Performer, turn on MIDI Machine Control by pressing this button. This brings on line all the recorders connected to the DTP or MTP AV.

AudioDesk automatically scans the DTP or MTP AV for connected recorders, and they appear here.

Use this setup if you have:

✓ ADATs, Alesis hard disk recorders or any ADAT SYNC compatible device(s).
✓ A MOTU Digital Timepiece, MIDI Timepiece AV or other ADAT synchronizer.
✓ Host software that supports sample-accurate sync.

This setup provides:

✓ Sample-accurate locating between all ADAT SYNC-compatible devices, the 896HD and your software (AudioDesk, Digital Performer or other sample-accurate software).
✓ With a Digital Timepiece, this setup provides sample-accurate locating across all devices: ADAT, Tascam and the 896HD.
✓ Transport control of everything from the computer, OR continuous sync to SMPTE time code and other sync sources (the other source is the transport master in this case).
SAMPLE-ACCURATE ADAT SYNC WITH NO SYNCHRONIZER

Even if you don’t have an ADAT synchronizer, you can achieve sample-accurate sync between ADAT-sync compatible devices, an 896HD, and any sample-accurate software (such as AudioDesk or Digital Performer). Just connect the 896HD to the end of the ADAT sync chain as shown below. You don’t get transport control from your computer, nor can you slave the system to SMPTE time code. Instead, you have to play, stop, rewind and cue the system from the transports on your recorder. If you’re using the recorder as an additional source of analog inputs and outputs only (not for recording), see “Syncing optical devices” on page 25.

### Use this setup if you have:
- ADATs, Alesis hard disk recorders or any ADAT SYNC compatible device(s).
- No ADAT synchronizer.
- Host software that supports sample-accurate sync.

### This setup provides:
- Sample-accurate locating between all ADAT SYNC-compatible devices, the 896HD and your software (AudioDesk, Digital Performer or other sample-accurate software).
- No transport control of everything from the computer.
- No sync to SMPTE time code or other sync sources.

---

### In AudioDesk or Digital Performer:
1. Choose Receive Sync in the Setup menu (Basics menu under OS 9).
2. Choose the Sample-accurate option shown to the left.
3. Make sure that Slave to External Sync is checked in the Studio menu (Basics menu under OS 9).

To set the 896HD hardware clock source for sample-accurate sync:

1. In AudioDesk or Digital Performer, choose MOTU Audio System>Configure Hardware Driver from the Setup menu (or the Basics menu under OS 9), or run the MOTU FireWire Audio Console.
2. Choose ADAT 9-pin from the Clock Source menu as shown to above.
3. Make sure the Sample Rate setting matches the recorder and synchronizer.

---

**Figure 3-11: Sample-accurate sync between AudioDesk or Digital Performer and one or more ADAT-sync compatible devices — without an ADAT synchronizer.**
SYNCING TO VIDEO AND/OR SMPTE TIME CODE

To synchronize (continuously resolve) the 896HD with SMPTE time code, word clock, video or blackburst, you will need a MOTU Digital Timepiece, MIDI Timepiece AV or any other universal synchronizer equipped with word clock. The synchronizer resolves continuously to the chosen time base, and the 896HD slaves to the synchronizer via word clock. In addition, the audio software running on the computer slaves to MIDI Time Code generated by the synchronizer, as shown below in Figure 3-12. How accurate will transfers be between your audio software and other audio devices? As good as the resolution of MIDI time code, which — at 30 fps — provides quarter frame resolution of 120th of a second (367 samples at 44.1 KHz). But if you are running your synchronizer under its own internal clock (triggering it via MMC from your software), you will probably get even tighter timing than that — perhaps as good as ±50 samples.

Use this setup if you have:

- Video and/or a SMPTE time code source.
- A Digital Timepiece, MIDI Timepiece AV or other universal synchronizer.
- Host software that does not support sample-accurate sync (although you can use this setup even if it does).

This setup provides:

- No sample-accurate locating.
- Continuous sync to SMPTE time code.
- Sub-frame timing accuracy.
- Transport control from the SMPTE time code source.

Figure 3-12: Resolving the 896HD to an external time base, such as SMPTE time code, word clock, or video. In this example, an S-VHS video deck is supplying SMPTE time code (address) and video (as the time base). For examples of other sources, consult the MIDI Timepiece AV manual (or other synchronizer).
SYNCING OPTICAL DEVICES

The word *optical* is our short-hand way of referring to any device that connects to the 896HD via an optical cable. But we make a further distinction: an optical device is also one that doesn’t care about sample location. An example is a digital mixer. Since a digital mixer is not a recording device, it has no sense of sample location like an ADAT does. An ADAT can cue to a specific sample number (e.g. sample number 43,478, 103) — as can any device that supports ADAT sync, but most digital mixers simply mix and process audio digitally, with no sense of a specific sample location. There are many other devices that fall into this category, including digital effects processors, synthesizers, A/D converters, and many more.

For ADATs or other devices that support ADAT sync, synchronize them with the 896HD as described in the previous sections of this chapter.

For *optical* devices, such as digital mixers, all you have to do is make sure that their digital audio clock is phase-locked (in sync with) the 896HD. There are three ways to do this:

- Slave the optical device to the 896HD
- Slave the 896HD to the optical device
- Slave both the optical device and the 896HD to a third master clock (such as a Digital Timepiece or MIDI Timepiece AV synchronizer)

![Diagram of synchronization setups](image)

Figure 3-13: Three setups for synchronizing an optical device with the 896HD. You can slave the optical device to the 896HD or vice versa with their optical connections. For more elaborate setups, you can slave both to a digital audio synchronizer like the Digital Timepiece. Don’t use any of these setups for an ADAT or other optical device that records. Instead, see “Sample-accurate ADAT sync” on page 22.
SYNCING AES/EBU DEVICES
If you would like to transfer stereo audio digitally between the 896HD and another device that has AES/EBU I/O, connect it to the 896HD’s AES/EBU jacks with balanced, AES/EBU grade audio cables.

AES/EBU clock and sample rate conversion
The 896HD AES/EBU section is equipped with a real-time sample rate converter that can be used for either input or output. This feature provides a great deal of flexibility in making digital transfers. For example, you can:

- Transfer digital audio into the 896HD at a sample rate that is completely different than the 896HD system clock rate.
- Transfer digital audio into the 896HD without the need for any external synchronization arrangements.
- Transfer digital audio out of the 896HD at double or half the 896HD system clock rate.

Rate conversion does not add any appreciable noise to the audio signal (under -120 dB).

Digital audio phase lock
Without sample rate conversion, when you transfer digital audio between two devices, their audio clocks must be in phase with one another — or phase-locked — as demonstrated below in Figure 3-15. Otherwise, you’ll hear clicks, pops, and distortion in the audio, or perhaps no audio at all.

Figure 3-14: Two setups for synchronizing an AES/EBU device with the 896HD. In the top diagram, sync is achieved via the AES/EBU connection itself. In this case, you have to choose AES/EBU as the 896HD’s clock source when recording from the AES/EBU device. If you don’t want to have to worry about switching the Clock Source setting depending on the direction of the AES/EBU transfer, you can slave the AES/EBU device to word clock from the 896HD or vice versa (not shown). The Word Clock connection maintains sync, regardless of the direction of the transfer.
Installing the 896HD Hardware

27

Figure 3-15: When transferring audio without sample rate conversion, two devices must have phased-locked audio clocks to prevent clicks, pops or other artifacts.

Without sample rate conversion, there are two ways to achieve phase lock: slave one device to the other, or slave both devices to a third master clock. If you have three or more digital audio devices, you need to slave them all to a single master audio clock.

Audio phase lock as shown above in Figure 3-16 can be achieved independently of time code (location). For example, one device can be the time code master while another is the audio clock master. But only one device can be the audio clock master.

Another benefit of direct master/slave clocking (without sample rate conversion) is that each slaved device remains continuously resolved to the master, meaning that there will be no drift over time. This form of synchronization is best for audio that needs to remain resolved to film, video, etc.

Sample rate conversion

With sample rate conversion (SRC), an extra level of master/slave clocking is added to the equation, as demonstrated below in Figure 3-17, which shows the clocking going on when you transfer digital audio from the 896HD (AES/EBU OUT) to a DAT deck (AES/EBU IN) using SRC. Notice that with SRC, the DAT deck is not slaved to the 896HD’s system clock. Instead, their clocks are running completely independently of one another. But also notice that the DAT deck must still slave to the sample-rate-converted output from the 896HD for a clean digital audio transfer (unless it has its own sample rate converter on its AES/EBU input).

System clock, AES clock & rate convert settings

When you are setting up AES/EBU input and output with the 896HD, pay careful attention to the following settings in the MOTU FireWire Audio Console (see the quick reference overview on page 7):

- Clock source
- Sample rate conversion

These options are mentioned briefly in the following sections. For further details, see “Clock Source” on page 39 and “Sample Rate Conversion” on page 41.
Clocking scenarios for AES/EBU input

There are three possible clocking scenarios for the 896HD AES/EBU input:

1. Simple transfer (slave the 896HD system clock to the AES/EBU input signal — no sample rate conversion).
2. Sample rate convert the AES/EBU input.
3. Use word clock to resolve the 896HD system clock and the other AES/EBU device with each other.

These three AES/EBU input scenarios are summarized below.

<table>
<thead>
<tr>
<th>Scenario 1</th>
<th>Scenario 2</th>
<th>Scenario 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Simple transfer</td>
<td>Rate convert</td>
</tr>
<tr>
<td>896HD clock source setting</td>
<td>AES/EBU</td>
<td>Any setting except AES/EBU</td>
</tr>
<tr>
<td>Sample rate conversion setting</td>
<td>None</td>
<td>AES In</td>
</tr>
<tr>
<td>Required 896HD cable connections</td>
<td>AES/EBU In</td>
<td>AES In</td>
</tr>
<tr>
<td>Are the devices continuously resolved?</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Is the signal being sample rate converted?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Example application</td>
<td>Simple digital transfer into the 896HD from DAT deck or digital mixer.</td>
<td>Transfer from digital mixer running at a different sample rate.</td>
</tr>
</tbody>
</table>

Some example scenarios are demonstrated below.

Simple AES/EBU input transfer (no rate convert)

![Simple AES/EBU input transfer](image)

AES/EBU input with rate conversion

![AES/EBU input with rate conversion](image)

AES/EBU input with word clock

![AES/EBU input with word clock](image)

Clocking scenarios for AES/EBU output

The 896HD AES/EBU output can also employ sample rate conversion. The output options, shown below in Figure 3-21, are briefly summarized in the following sections. For further details, see "Sample Rate Conversion" on page 41.
INSTALLING THE 896HD HARDWARE

Figure 3-21: The Sample Rate Conversion option in the MOTU FireWire Audio Console gives you access to the AES/EBU output clock options. The last option is either “x2” or “÷2” depending on the system sample rate.

None
To make the AES/EBU output sample rate match the System sample rate, choose None. No sample rate conversion occurs when this setting is chosen.

AES Out slave to AES in
To make the AES/EBU output sample rate match the sample rate currently being received by the 896HD’s AES/EBU input, choose AES Input. This setting requires a connection to the 896HD’s AES/EBU input from a device that is transmitting an AES/EBU clock signal.

☛ Be careful when both the 896HD’s AES/EBU input and output are connected to the same external device: this option is likely to create a clock loop.

☛ When you are using the AES/EBU input as a clock source for sample rate conversion on the AES/EBU output, you cannot use the AES/EBU input for audio input.

AES Out x 2 / AES Out ÷ 2
Choose one of these sample rates when the desired AES/EBU output rate needs to be twice the 896HD system clock rate (when the system clock is at either 44.1 or 48 kHz) or half the system clock rate (when the system clock is at 88.2 or 96 kHz). For further details about this option, see “Sample Rate Conversion” on page 41.

SYNCING WORD CLOCK DEVICES
The 896HD word clock connectors allow you to synchronize it with a wide variety of other word clock-equipped devices.

For standard word clock sync, you need to choose an audio clock master (as explained in “Be sure to choose a digital audio clock master” on page 19). In the simplest case, you have two devices and one is the word clock master and the other is the slave as shown below in Figure 3-22 and Figure 3-23.

Don’t chain word clock
If you have three or more digital audio devices that you need to synchronize, avoid chaining their word clock connections (OUT to IN, OUT to IN, etc.), as...
this causes problems. Instead, use a dedicated synchronizer like the Digital Timepiece or a word clock distribution device of some kind.

**Slaving to a 2x and 1/2x word clock**
The 896HD has the ability to slave to a word clock signal running at either twice or half their current clock rate. For example, the 896HD could be running at 96 kHz while slaving to a 48 kHz word clock signal from a MOTU Digital Timepiece. Similarly, the 896HD could run at 88.2 kHz and slave to 44.1 kHz word clock. Conversely, the 896HD could run at 48 kHz and slave to a 96 kHz word clock signal. In all of these cases, the front panel clock LEDs flash both sample rates to indicate that the 896HD is slaving to word clock at either twice or half its own clock rate. But if the 896HD is running at 96 kHz, it cannot slave to word clock running at 44.1 kHz.

Remember, the word clock signal must be one of the following:

- the same as the 896HD clock
- twice the 896HD clock
- half of the 896HD clock

**Forcing a 1x word out rate**
The 896HD can generate a word clock output signal that either matches the current system clock rate (any rate between 44.1 and 192kHz) or the corresponding 1x rate. For example, if the 896HD is operating at 192kHz, you can choose to generate a word out rate of 48kHz. For details on how to make this word clock output setting, see “Word Out” on page 43.

**SYNCING LARGE SYSTEMS**
If you are connecting the 896HD to a lot of other digital audio gear, get a Digital Timepiece. It can synchronize a wide variety of devices, and it offers sample accurate synchronization for devices that support it, such as ADATs. You will also be able to control everything from the transport controls of your audio software. If you have even more devices than a single Digital Timepiece can support, consider a word clock distribution device, such as the Aardvark Aard Sync™ video-to-word clock converter. Products like this offer multiple word clock outputs and an extremely low-jitter clock.
CONNECTING MULTIPLE MOTU FIREWIRE INTERFACES
You can daisy-chain up to four MOTU FireWire interfaces on a single FireWire bus, with the restrictions described in the following sections. Most computers have only one built-in FireWire bus (even if it supplies multiple FireWire sockets). Connect them as follows:

Multiple interfaces in the MOTU FireWire Audio Console
The MOTU FireWire Audio Console displays the settings for one interface at a time. To view the settings for an interface, click its tab as shown below in Figure 3-25.

Using multiple interfaces under Mac OS X
When using multiple interfaces under Mac OS X, choose one interface as the master clock source and then slave the rest to it. All interfaces will remain resolved to each other via the master interface. The master interface can be any audio interface (PCI, FireWire or otherwise) that appears in the MOTU FireWire Console Clock Source menu.

Figure 3-24: Connecting multiple 896HD's (or other MOTU FireWire audio interfaces) to a computer.

Figure 3-25: To view the settings for an interface, click its tab. Under Mac OS 9, choose it from the Interface menu as shown.
Make the Clock Source settings for each interface as follows:

- For the master interface, click its tab (as demonstrated in Figure 3-25) and choose any clock source you wish (except any of the slave interfaces, of course).
- For each slave interface, click its tab and choose the master interface from the Clock Source menu. This causes the slave interfaces to resolve to the master interface.

Using multiple interfaces under Mac OS 9
All connected MOTU FireWire interfaces get their clock from whatever you choose from the Clock Source menu in the MOTU FireWire Audio Console. When you connect multiple MOTU FireWire interfaces, all of their respective sync sources are displayed in the menu as shown below in Figure 3-26.

Figure 3-26: In Mac OS 9, all MOTU FireWire audio interfaces get their clock from a single master sync source on any connected 896HD (or other MOTU FireWire interface). After you choose a source from this menu, the entire system, including all connected 896HDs, synchronizes to it.

Under Mac OS 9, each FireWire interface in the system gets its clock from the FireWire cable connection (unless it is the master clock itself). There is no need to make word clock connections between multiple FireWire interfaces.

Connecting an 828
You can add an original MOTU 828 to the end of a FireWire daisy chain (because the 828 has only one FireWire port), or you can mix and match multiple 828’s with other MOTU FireWire interfaces using a standard FireWire hub. Up to four interfaces can be combined on one FireWire bus.

Operating multiple FireWire interfaces at high sample rates
Four MOTU FireWire interfaces can operate at 44.1 or 48kHz on a single FireWire bus. At the high sample rates (88.2 or 96kHz), you can operate no more than two FireWire interfaces on a single FireWire bus.

Adding additional interfaces with a second FireWire bus
Third-party FireWire bus expansion products in the form of a cardbus (“PC card”) adaptor or PCI card allow you to add a second FireWire bus to your computer. It may be possible to add additional MOTU FireWire interfaces connected to such a third-party product, depending on the performance of the product and the performance of your host computer.

Managing the IDs of multiple interfaces (Mac OS 9 only)
Multiple 896HD interfaces are identified by number (#1, #2, #3, etc.) Interfaces are ID’d (given a number) by the order in which they are first powered up after being connected. This information is stored in the MOTU FireWire Audio preferences file. Once ID’d, they retain the same number regardless of the order in which they are powered up. You can disable an interface at any time with the Disable interface option shown in Figure 3-25 on page 31. Doing so frees up the FireWire bandwidth required by the interface without turning it off. Switching off an interface accomplishes the same thing. To get the MOTU FireWire Audio Control Panel Console to forget about an interface entirely, you’ll see a Forget button in the MOTU FireWire Audio Console. Just click the Forget button and the MOTU FireWire Audio Console will no longer consider the interface to be present but off line (turned off).
# Chapter 4 Installing the 896HD Macintosh Software

## Overview

| Software installation for Mac OS X | 33 |
| Software installation for Mac OS 9 | 34 |
| CueMix Console | 35 |
| AudioDesk workstation software | 36 |

### Software Installation for Mac OS X

Install the 896HD software as follows:

1. Insert the MOTU FireWire Installer disc and launch the installer.

2. Follow the directions that the installer gives you.

### What does the OS X installer do?

The installer checks the computer to make sure it satisfies the minimum system requirements for your MOTU interface. If so, the installer proceeds with the OS X installation. Drivers are installed, along with the MOTU FireWire Audio Console, FireWire CueMix Console, and several other applications, summarized in the following table:

<table>
<thead>
<tr>
<th>Software component</th>
<th>Location</th>
<th>Purpose</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOTU FireWire CoreAudio driver</td>
<td>/System/Library/Extensions</td>
<td>Provides 896HD multi-channel audio input and output with all Mac OS X audio software</td>
<td>“The 896HD CoreAudio driver” on page 33</td>
</tr>
<tr>
<td>MOTU FireWire Audio Console</td>
<td>Applications folder</td>
<td>Provides access to all of the settings in the 896HD and other MOTU FireWire interfaces. Required for 896HD operation.</td>
<td>chapter 5, “MOTU FireWire Audio Console (Mac OS X)” (page 37)</td>
</tr>
<tr>
<td>AudioDesk Demo Project</td>
<td>Anywhere you want</td>
<td>Provides a multi-track mix that you can open, play, and mix in AudioDesk. Optional.</td>
<td>AudioDesk User Guide</td>
</tr>
<tr>
<td>FireWire CueMix Console</td>
<td>Applications folder</td>
<td>Gives you complete control over the 896HD’s CueMix DSP feature, which provides no-latency monitoring and mixing of live inputs through your 896HD system.</td>
<td>chapter 12, “CueMix Console” (page 93)</td>
</tr>
</tbody>
</table>

The 896HD CoreAudio driver

CoreAudio is a term that refers to the software technology built into Mac OS X that provides all of its standardized audio features. More specifically, we use CoreAudio to refer to Mac OS X's standard audio driver model. A CoreAudio driver allows the 896HD to establish audio input and output with any Mac OS X CoreAudio-compatible software.

Once the 896HD’s CoreAudio driver has been successfully installed (by the installer), and you have chosen it for use in your host audio software, the 896HD will appear as a choice for audio inputs and outputs in your software.

All MOTU audio hardware, including our PCI systems and other FireWire interfaces, ship with CoreAudio drivers that allow them to operate successfully with virtually all Mac OS X audio software.
SOFTWARE INSTALLATION FOR MAC OS 9

Install the 896HD software as follows:

1. Insert the MOTU FireWire Installer disc and launch the installer.
2. Follow the directions that the installer gives you.

What does the OS 9 installer do?
The 896HD ships with the following Mac OS 9 software components:

<table>
<thead>
<tr>
<th>Software component</th>
<th>Location</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOTU FireWire Audio Driver</td>
<td>Extensions Folder</td>
<td>Allow the 896HD to establish communication with the computer.</td>
</tr>
<tr>
<td>MOTU FireWire Enabler</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MOTU Folder</td>
<td>Extensions Folder</td>
<td>Contains the MOTU hard disk recording engine. Required for 896HD operation with AudioDesk and Digital Performer.</td>
</tr>
<tr>
<td>MOTU FireWire Control Panel</td>
<td>Apple menu (Control Panels Folder)</td>
<td>Provides access to all of the settings in the 896HD hardware.</td>
</tr>
<tr>
<td>MOTU FireWire Control Strip</td>
<td>Control Strip Modules Folder</td>
<td>Provides access to all of the settings in the 896HD hardware.</td>
</tr>
<tr>
<td>AudioDesk Workstation Software</td>
<td>Top level of the startup disk</td>
<td>Provides complete multi-track recording, mixing and processing. Optional.</td>
</tr>
<tr>
<td>ASIO MOTU FireWire Audio Driver</td>
<td>In the ASIO Drivers folder of your audio software—other than AudioDesk or Digital Performer</td>
<td>Allows ASIO-compliant audio software to do multi-channel input and output with the 896HD. Only required if you are using Cubase or another ASIO-compatible program.</td>
</tr>
<tr>
<td>AudioDesk Demo Project</td>
<td>Anywhere you want</td>
<td>Provides a multi-track mix that you can open, play, and mix in AudioDesk. Optional.</td>
</tr>
</tbody>
</table>

MOTU FireWire Audio Control Panel
The MOTU FireWire Audio Console is placed by the installer in your Mac’s Apple menu (under Control Panels). It gives you access to all of the settings in the 896HD hardware, such as the sample rate. For complete details, see chapter 6, “MOTU FireWire Control Panel (Mac OS 9)” (page 45).

MOTU FireWire Control strip module
The MOTU FireWire Control Strip module is placed by the installer in your Mac’s Control Strip. Just like the MOTU FireWire Audio Console, it gives you access to all of the settings in the 896HD hardware. For complete details, see chapter 6, “MOTU FireWire Control Panel (Mac OS 9)” (page 45).
Figure 4-2: The MOTU FireWire Control Strip module gives you access to all of the settings in the MOTU FireWire hardware, just like the MOTU FireWire Audio Console.

**ASIO MOTU FireWire Audio driver**

ASIO stands for Audio Streaming Input and Output. The ASIO MOTU FireWire Audio driver allows 896HD to provide multi-channel input and output for Steinberg's Cubase VST software, or any other audio application that supports ASIO drivers.

The ASIO MOTU FireWire Audio driver is only required if you are using Cubase VST (or another audio program that relies on the ASIO driver to support multi-channel I/O with the 896HD).

- Digital Performer and AudioDesk support ASIO, but they also access the 896HD directly through the MOTU Audio System, so it is not necessary to use the ASIO driver with these MOTU applications.

The ASIO MOTU FireWire Audio driver should be placed in the ASIO folder of Cubase VST or other ASIO-compliant software that you are running as the software “front end” for the 896HD.

For details about using Cubase VST with the 896HD, see chapter 10, “Cubase, Nuendo and OS 9 ASIO Software” (page 75).

Figure 4-3: The ASIO MOTU FireWire Audio driver.

**CUEMIX CONSOLE**

This program provides a mixing console that gives you control over the 896HD's no-latency CueMix DSP features. For details, see chapter 12, “CueMix Console” (page 93).

Figure 4-4: CueMix Console.
AUDIODESK WORKSTATION SOFTWARE

The MOTU FireWire installer places AudioDesk on the top level of your Macintosh’s startup volume.

AudioDesk is an advanced workstation software package for the 896HD that lets you record, edit, mix, process, bounce and master multi-track digital audio recording projects. Advanced features include real-time 32-bit effects processing, sample-accurate synchronization with ADATs, 24-bit recording, and much more.

See the AudioDesk manual included with your 896HD system for details.
CHAPTER 5  MOTU FireWire Audio Console
(Mac OS X)

OVERVIEW
Accessing the 896HD settings ............... 37
896HD Settings .................................. 38
Sample Rate ..................................... 38
Clock Source ................................... 39
Default Stereo Input/Output .................. 40
Optical input/output ............................ 41
Phones ............................................. 41
Sample Rate Conversion ....................... 41
Programmable Meters ......................... 42
AES/EBU Meters ................................. 42
Clip Hold Time .................................. 42
Peak Hold Time .................................. 42
Word Out ......................................... 43
‘General’ tab settings ......................... 43
Enable Pedal ...................................... 43
Launch console when hardware becomes available 43
Edit Channel Names ............................ 43

ACCESSING THE 896HD SETTINGS
There are several ways to access the MOTU FireWire Audio Console settings:

■ Click the MOTU FireWire Audio Console icon in the dock
■ Press on the MOTU FireWire Audio Console dock icon to open the menu shown below, or control-click it to open the menu immediately

■ From within AudioDesk™ or Digital Performer™, choose Setup menu> MOTU Audio System options> Configure Hardware Driver (Note: this dialog only provides access to basic settings such as sample rate and clock source. For access to all settings, use one of the techniques above.)
■ From within Cubase VST, go to the Audio menu, choose System and then click the ASIO Control Panel button. In Cubase SX, open the Devices Setup window, click the VST Multitrack device and click the Control Panel button.
From within other ASIO-compatible programs, refer to their documentation.

**General tab settings**
The General tab provides settings that apply globally to all connected MOTU FireWire interfaces.

**896HD tab settings**
The 896HD tab provides settings that apply to a specific 896HD interface. If you have several 896HD's (or other MOTU FireWire audio interfaces) connected, you'll see a separate tab for each one.

**896HD SETTINGS**

**Sample Rate**
Choose the desired Sample Rate for recording and playback. The 896HD can operate at 44.1 (the standard rate for compact disc audio), 48, 88.2, 96, 176.4 or 192KHz. If you are operating at a sample rate between 44.1 and 96kHz, make absolutely sure that all of the devices connected digitally to the 896HD match the 896HD's sample rate. Also make sure that your Digital Timepiece, MIDI Timepiece AV or other digital audio synchronizer matches it as well. At the 4x sample rates (176.4 or 192kHz), all digital I/O on the 896HD is disabled.

Mismatched sample rates cause distortion and crackling. If you hear this sort of thing, check the sample rate settings in your hardware and here in the MOTU FireWire Audio Console.

**Operation at 4x sample rates (176.4 or 192kHz)**
At the 4x sample rates (176.4 or 192kHz), operation of the 896HD is restricted, due to the higher audio bandwidth demands, as follows:

![Image](image-url)
■ All digital I/O is disabled (there is no optical and no AES/EBU input/output).
■ The 896HD provides 8 channels of analog input and 10 channels of analog output (8 XLR outputs plus stereo headphone out), simultaneously.
■ CueMix DSP supports 2 independent monitor mixes (instead of 4, as with the lower sample rates). For details about CueMix DSP, see chapter 12, “CueMix Console” (page 93).
■ The Mix1 input, as described in “Mix1 1-2” on page 64, is not available.
■ The headphone output can be assigned to any analog output pair or the Phones setting (as described in “Phones” on page 41). But at the 4x sample rates, the Phones output is not available from the computer. Instead, it is only available as a destination for the two CueMix DSP mixes. In other words, it can only take CueMix inputs.
■ The main outs mirror the phones.

Clock Source
The Clock Source determines the digital audio clock that the 896HD will use as its time base. For a complete explanation of synchronization issues, see “Making sync connections” on page 19. The following sections briefly discuss each clock source setting.

Internal
Use the Internal setting when you want the 896HD to operate under its own digital audio clock. For example, you may be in a situation where all you are doing is playing tracks off hard disk in your digital audio software on the computer. In a situation like this, you most often don’t need to reference an external clock of any kind.

Another example is transferring a mix to DAT. You can operate the 896HD system on its internal clock, and then slave the DAT deck to the 896HD via the AES/EBU connection (usually DAT decks slave to their AES/EBU input when you choose the AES/EBU input as their record source) or via the 896HD’s word clock output (if your DAT deck has a word clock input).

If you would like help determining if this is the proper clock setting for your situation, see “Do you need a synchronizer?” on page 20.

With ADAT devices, however, you usually want an external digital audio synchronizer, such as the MIDI Timepiece AV or Digital Timepiece, to be the digital clock master. In this case, you would set the 896HD clock source setting to ADAT 9-pin, as described below.

AES/EBU
The AES/EBU clock source setting refers to the AES/EBU input connector on the 896HD. This setting allows the MOTU 896HD to slave to another AES/EBU device.

Use this setting whenever you are recording input from a DAT deck or other AES/EBU device into the 896HD. It is not necessary in the opposite direction (when you are transferring from the 896HD to the DAT machine).

For further details about this setting, see “Syncing AES/EBU devices” on page 26.

Word Clock In
The Word Clock In setting refers to the Word Clock In BNC connector on the 896HD rear panel. Choosing this setting allows the 896HD to slave to an external word clock source, such as the word clock output from a digital mixer or another MOTU FireWire interface.

ADAT 9-pin
The ADAT 9-pin clock source setting refers to the ADAT digital audio synchronization format. It allows the 896HD to slave to an ADAT — or ADAT sync chain — via its ADAT sync 9-pin connector. ADAT sync also carries precise, sample location
information, which allows AudioDesk and Digital Performer to transfer audio to and from ADAT-sync compatible recorders without drifting by as much as one sample.

Use this setting when you are using the 896HD with one or more ADAT-sync compatible recorders. Make sure the 896HD is connected to the end of the ADAT sync chain.

You should also use this setting if you have a MIDI Timepiece AV, which allows you to drive your entire system from the transport controls of AudioDesk, Digital Performer or other computer software.

You could also use ADAT sync to continuously resolve the 896HD to SMPTE time code, video, and word clock via a synchronizer like the MOTU MIDI Timepiece AV. Word clock can accomplish the same thing.

For further details, see “Sample-accurate ADAT sync” on page 22, “Sample-accurate ADAT sync with no synchronizer” on page 23 and “Syncing to video and/or SMPTE time code” on page 24.

ADAT optical
The ADAT optical clock source setting refers to the clock provided by the 896HD’s optical input, when it is connected to an ADAT optical device. This setting can be used to slave the 896HD directly to the optical input connection. Most of the time, you can set up a better operating scenario that uses one of the other synchronization options. However, there may be occasions when you have an ADAT optical compatible device that has no way of synchronizing digitally to the 896HD or an external synchronizer such as the Digital Timepiece. In this case, the ADAT Optical clock source setting lets you slave the 896HD to the device itself via its digital input to the 896HD.

If the ADAT Optical setting does not appear in the Clock Source menu, it means that the 896HD’s optical input is currently turned off. Choose the ADAT optical format from the Optical input menu (Figure 5-1 on page 38).

This setting is also useful if you just need to make a simple, click-free digital transfer between the 896HD and another device — where a time code reference and shared transport control are not needed — without having to set up an elaborate synchronization scenario.

For further details about this setting, see “Syncing optical devices” on page 25.

Other audio interfaces
You may see other audio interfaces in the Clock Source list, such as another MOTU FireWire interface, a MOTU PCI-324 or PCI-424 system, the Macintosh built-in audio, or perhaps even another third-party audio interface. The 896HD can resolve to these other audio devices via their CoreAudio driver. This allows you to play and record audio with your host audio software via both interfaces at the same time without their audio streams drifting apart from one another over long recording or playback passes. No external synchronization connections are required for this setting, as the two devices are entirely resolved via the software driver.

Default Stereo Input/Output
In the System Preferences window, Mac OS X lets you choose third-party hardware such as the 896HD for your Macintosh sound input and output. The system input and output can be used for alert sounds and general audio I/O for applications like iTunes, iMovie, etc.
The **Default Stereo Input** and **Default Stereo Output** settings in the MOTU FireWire Console (Figure 5-1 on page 38) let you specify the stereo input and output on the 896HD to be used when it is chosen as the audio I/O device in the system preferences.

Note: The Default Stereo Input/Output settings have the following system software requirements:

- Mac OS X 10.2.x together with QuickTime 6.4 OR
- Mac OS X 10.3 (aka Panther) or later

If your Macintosh system software does not meet these minimum requirements, the Default Stereo Input/Output options do not appear in the MOTU FireWire Console window.

**Optical input/output**
The **Optical input** and **Optical output** settings let you choose between ADAT (‘lightpipe’) or OFF. Turning it off frees up FireWire bandwidth. In other words, it opens up resources on the FireWire bus for other devices connected via FireWire.

**Phones**
The **Phones** setting lets you choose what you will hear from the headphone jack. Choose **Main Outs** if you’d like the headphone output to match the main outs. Choose **Phones** if you would like the headphones to serve as their own independent output, which you can access as an independent output destination in your host audio software and as an output destination for the four on-board CueMix DSP mix busses.

At the 4x sample rates (176.4 and 192kHz), the headphone output can be assigned to any analog output pair or the **Phones** setting, as described above. But at the 4x sample rates, the **Phones** output is not available as an output destination for software on the computer. Instead, it is only available as a destination for the two CueMix DSP mixes. In other words, it can only take CueMix inputs.

**Sample Rate Conversion**
This option lets you control AES/EBU sample rate conversion. Sample rate conversion is available when the 896HD is operating at the 1x sample rates (44.1 and 48kHz) or the 2x sample rates (88.2 or 96kHz). AES/EBU is disabled entirely at the 4x samples rates (176.4 and 192kHz). Each option is explained below.
None
No sample rate conversion occurs. Both the AES/EBU input and output match the sample rate of the 896HD’s system clock.

AES In
The AES/EBU input locks to the sample rate of the input signal (whatever it happens to be) and converts it to the 896HD system clock rate. The Rate Conversion LEDs on the 896HD front panel indicate the incoming sample rate and that rate conversion is occurring.

AES Out slave to AES in
To make the AES/EBU output sample rate match the sample rate currently being received by the 896HD’s AES/EBU input, choose AES Out slave to AES in. This setting requires a connection to the 896HD’s AES/EBU input from a device that is transmitting an AES/EBU clock signal.

☛ Be careful when both the 896HD’s AES/EBU input and output are connected to the same external device: this option is likely to create a clock loop.

☛ When you are using the AES/EBU input as a clock source for sample rate conversion on the AES/EBU output, you cannot use the AES/EBU input for audio input.

AES Out x 2 / AES Out ÷ 2
Choose one of these sample rates when the desired AES/EBU output rate needs to be twice the 896HD system clock rate (when the system clock is at either 44.1 or 48 kHz) or half the system clock rate (when the system clock is at 88.2 or 96 kHz). Either way, the AES/EBU output remains resolved to the 896HD system clock. For further details about this option, see “Syncing AES/EBU devices” on page 26.

Programmable Meters
This option lets you choose which bank you wish to monitor with the eight programmable meters on the MOTU 896HD front panel. Your choices are: Analog Out, ADAT In or ADAT Out. You can also adjust this setting by repeatedly pushing the VOLUME knob on the 896HD front panel.

AES/EBU Meters
This option lets you choose to monitor either AES/EBU input or output with the programmable AES/EBU meters on the MOTU 896HD front panel. You can also adjust this setting by repeatedly pushing the VOLUME knob on the 896HD front panel.

Clip Hold Time
The Clip Hold Time option controls how long the top red LED remains illuminated after clipping occurs (see Figure 5-3 below).

If you want the ability to clear the LED manually from your host audio software or the Cue Mix Console, Choose Infinite from the Clip Hold Time menu. In Digital Performer or AudioDesk, you can clear the 896HD clip LEDs by choosing Audio menu>Clear All Clipping Indicators.

Peak Hold Time
The 896HD front-panel level meters support standard peak/hold metering, where the LED for the highest level recently measured on the channel remains illuminated for a brief period of time while the rest of the LEDs below it remain fully dynamic. The Peak Hold Time controls how long the peak-hold LED remain illuminated before going dark again.
**Word Out**
The Word Out menu appears when the 896HD is operating at a 2x sample rate (88.2 or 96kHz) or 4x sample rate (176.4 or 192kHz). This menu lets you set the word clock output either to match the current sample rate (System Clock) or force it to the corresponding 1x rate (either 44.1 or 48kHz). For example, if the 896HD were operating at 176.4kHz, choosing the Force 44.1/48kHz option would produce word clock output at 44.1kHz.

**‘GENERAL’ TAB SETTINGS**

**Enable Pedal**
Check the Enable Pedal option if a foot switch is connected to the 896HD and you would like to trigger recording punch in/out (or other software functions) with it. Use the Set buttons to determine what keystroke is triggered by the pedal-up and pedal-down positions. You can assign the pedal to any two keystrokes you wish. (You are not restricted to punch in/out.)

**Launch console when hardware becomes available**
Check this option if you would like the MOTU FireWire Audio Console icon to appear in the application dock as soon as a MOTU FireWire interface is detected (switched on, plugged in, etc.)

**Edit Channel Names**
Click the Edit Channel Names button to open the Channel Names window (Figure 5-4). This window lets you edit the names of the 896HD inputs and outputs, as they appear in your host audio software. For example, when you click on a menu that displays the 896HD inputs (or outputs), you will see the names you specify in this window (e.g. “vocal mic”, “lead guitar”, etc.), instead of the default generic names (“Analog 1”, “Analog 2”, etc.)

There are several conditions for your custom channel names to appear in your Mac OS X audio software. First, your software must support Mac OS X’s port naming features. Secondly, this feature has the following system software requirements:

- Mac OS X 10.2.2 together with QuickTime 6.4
- Mac OS X 10.3 (aka Panther) or later

If your Macintosh system software does not meet these minimum requirements, the Default Stereo Input/Output options do not appear in the MOTU FireWire Console window, and you’ll see generic port names in your host audio software.

*Figure 5-4: The Edit Channel Names window.*
Figure 5-5: 896HD channel names as they appear in Digital Performer.
CHAPTER 6  MOTU FireWire Control Panel (Mac OS 9)

OVERVIEW
The MOTU FireWire Control Panel provides access to all 896HD settings. These settings can also be accessed from the MOTU FireWire Control Strip module or from the Configure Hardware Driver command in AudioDesk or Digital Performer (Basics menu).

ACCESSING THE 896HD SETTINGS
There are several ways to access the MOTU FireWire Control Panel settings:

■ From the Apple menu, choose the MOTU FireWire Control Panel

■ From the MacOS control strip, click on the MOTU FireWire Control Strip Module

■ From within AudioDesk™ or Digital Performer™, choose Basics menu>MOTU Audio System options>Configure Hardware Driver

■ From within Cubase (Version 5 or higher), click the ASIO Control Panel button in the System Setup dialog as shown in Figure 10-3 on page 78.

Accessing the 896HD settings .................................. 45
896HD Settings .................................................. 46
Sample Rate ...................................................... 46
Clock Source ..................................................... 46
Samples Per Buffer .............................................. 48
Enable Sound Manager driver ................................. 49
Enable Pedal ....................................................... 49
Interface menu .................................................. 49
Disable ............................................................. 49
Optical input/output ............................................ 49
Phones .............................................................. 49
Sample Rate Conversion ...................................... 50
Programmable Meters .......................................... 50
AES/EBU Meters .................................................. 50
Clip Hold Time ................................................... 50
Peak Hold Time .................................................. 51
Word Out .......................................................... 51
If 896HD settings are grayed out ......................... 51
From within other ASIO-compatible programs, refer to their documentation.

It doesn't matter which way you access the 896HD settings. They are the same in all three places.

896HD SETTINGS

Sample Rate
Choose the desired Sample Rate for recording and playback. The 896HD can operate at 44.1 (the standard rate for compact disc audio), 48, 88.2, 96, 176.4 or 192kHz. If you are operating at a sample rate between 44.1 and 96kHz, make absolutely sure that all of the devices connected digitally to the 896HD match the 896HD’s sample rate. Also make sure that your Digital Timepiece, MIDI Timepiece AV or other digital audio synchronizer matches it as well. At the 4x sample rates (176.4 or 192kHz), all digital I/O on the 896HD is disabled.

Mismatches sample rates cause distortion and crackling. If you hear this sort of thing, check the sample rate settings in your hardware and here in the MOTU FireWire Audio Console.

Operation at 4x sample rates (176.4 or 192kHz)
At the 4x sample rates (176.4 or 192kHz), operation of the 896HD is restricted, due to the higher audio bandwidth demands, as follows:

- All digital I/O is disabled (there is no optical and no AES/EBU input/output).
- The 896HD provides 8 channels of analog input and 10 channels of analog output (8 XLR outputs plus stereo headphone out), simultaneously.
- CueMix DSP supports 2 independent monitor mixes (instead of 4, as with the lower sample rates). For details about CueMix DSP, see chapter 12, “CueMix Console” (page 93).
- The Mix1 input, as described in “Mix1 1-2” on page 64, is not available.
- The headphone output can be assigned to any analog output pair or the Phones setting (as described in “Phones” on page 49). But at the 4x sample rates, the Phones output is not available from the computer. Instead, it is only available as a destination for the two CueMix DSP mixes. In other words, it can only take CueMix inputs.
- The main outs mirror the phones.

Clock Source
The Clock Source determines the digital audio clock that the 896HD will use as its time base. For a complete explanation of synchronization issues, see “Making sync connections” on page 19. The following sections briefly discuss each clock source setting.

Internal
Use the Internal setting when you want the 896HD to operate under its own digital audio clock. For example, you may be in a situation where all you
are doing is playing tracks off hard disk in your
digital audio software on the computer. In a
situation like this, you most often don’t need to
reference an external clock of any kind.

Another example is transferring a mix to DAT. You
can operate the 896HD system on its internal
clock, and then slave the DAT deck to the 896HD
via the AES/EBU connection (usually DAT decks
slave to their AES/EBU input when you choose the
AES/EBU input as their record source) or via the
896HD’s word clock output (if your DAT deck has
a word clock input).

If you would like help determining if this is the
proper clock setting for your situation, see “Do you
need a synchronizer?” on page 20.

With ADAT devices, however, you usually want an
external digital audio synchronizer, such as the
MIDI Timepiece AV or Digital Timepiece, to be the
digital clock master. In this case, you would set the
896HD clock source setting to ADAT 9-pin, as
described below.

AES/EBU
The AES/EBU clock source setting refers to the
AES/EBU input connector on the 896HD. This
setting allows the MOTU 896HD to slave to
another AES/EBU device.

Use this setting whenever you are recording input
from a DAT deck or other AES/EBU device into the
896HD. It is not necessary in the opposite direction
(when you are transferring from the 896HD to the
DAT machine).

For further details about this setting, see “Syncing
AES/EBU devices” on page 26.

Word Clock In
The Word Clock In setting refers to the Word Clock
In BNC connector on the 896HD rear panel.
Choosing this setting allows the 896HD to slave to
an external word clock source, such as the word
clock output from a digital mixer or another
MOTU FireWire interface.

ADAT 9-pin
The ADAT 9-pin clock source setting refers to the
ADAT digital audio synchronization format. It
allows the 896HD to slave to an ADAT — or ADAT
sync chain — via its ADAT sync 9-pin connector.
ADAT sync also carries precise, sample location
information, which allows AudioDesk and Digital
Performer to transfer audio to and from ADATs
without drifting by as much as one sample.

Use this setting when you are using the 896HD
with one or more ADATs. Make sure the 896HD is
clocked to the end of the ADAT sync chain.

You should also use this setting if you have a MIDI
timecode, which allows you to drive your
entire system from the transport controls of
AudioDesk, Digital Performer or other software.

You could also use ADAT sync to continuously
resolve the 896HD to SMPTE time code, video,
and word clock via a synchronizer like the MOTU
MIDI Timepiece AV. Word clock can accomplish
the same thing.

For further details, see “Sample-accurate ADAT
sync” on page 22, “Sample-accurate ADAT sync
with no synchronizer” on page 23 and “Syncing to
video and/or SMPTE time code” on page 24.

ADAT optical
The ADAT optical clock source setting refers to the
clock provided by the 896HD’s optical input, when
it is connected to an ADAT optical device. This
setting can be used to slave the 896HD directly to
the optical input connection. Most of the time, you
can set up a better operating scenario that uses one
of the other synchronization options. However,
there may be occasions when you have an ADAT
optical compatible device that has no way of
synchronizing digitally to the 896HD or an external synchronizer such as the Digital Timepiece. In this case, the ADAT Optical clock source setting lets you slave the 896HD to the device itself via its digital input to the 896HD.

If the ADAT Optical setting does not appear in the menu, it means that the 896HD’s optical input is currently either turned off. Choose the ADAT optical format from the Optical input menu (Figure 6-1 on page 46).

This setting is also useful if you just need to make a simple, click-free digital transfer between the 896HD and another device — where a time code reference and shared transport control are not needed — without having to set up an elaborate synchronization scenario.

For further details about this setting, see “Syncing optical devices” on page 25.

Other audio interfaces
You may see other audio interfaces in the Clock Source list, such as another MOTU FireWire interface, a MOTU PCI-324 or PCI-424 system, the Macintosh built-in audio, or perhaps even another third-party audio interface. The 896HD can resolve to these other audio devices via their CoreAudio driver. This allows you to play and record audio with your host audio software via both interfaces at the same time without their audio streams drifting apart from one another over long recording or playback passes. No external synchronization connections are required for this setting, as the two devices are entirely resolved via the software driver.

Samples Per Buffer
The Samples Per Buffer setting lets you reduce the delay you hear when patching live audio through your audio software. For example, you might have a live microphone input that you would like to run through a reverb plug-in that you are running in your host audio software. When doing so, you may hear or feel some “sponginess” (delay) between the source and the processed signal. If so, don’t worry. This effect only affects what you hear: it is not present in what is actually recorded.

You can use Samples Per Buffer setting to reduce this monitoring delay—and even make it completely inaudible.

☛ If you don’t need to process an incoming live signal with software plug-ins, you can monitor the signal with no delay at all using CueMix Console, which routes the signal directly to your speakers via hardware. For details, see chapter 12, “CueMix Console” (page 93).

Adjusting the Samples Per Buffer setting impacts the following things:

- The strain on your computer’s CPU
- The delay you hear when routing a live signal through your host audio software plug-ins
- How responsive the transport controls are in your software

This setting presents you with a trade-off between the processing power of your computer and the delay of live audio as it is being processed by plug-ins. If you reduce the Samples Per Buffer, you reduce patch thru latency, but significantly increase the overall processing load on your computer, leaving less CPU bandwidth for things like real-time effects processing. On the other hand, if you increase the Samples Per Buffer, you reduce the load on your computer, freeing up bandwidth for effects, mixing and other real-time operations. But don’t set the Samples Per Buffer too low, or it may cause distortion in your audio.

If you don’t process live inputs with software plug-ins, leave this setting at its default value of 1024 samples. If you do, try settings of 256 samples or less, if your computer seems to be able to handle
them. If your host audio software has a processor meter, check it. If it starts getting maxed out, or if the computer seems sluggish, raise the Samples Per Buffer until performance returns to normal.

If you are at a point in your recording project where you are not currently working with live, patched-thru material (e.g. you're not recording vocals), or if you have a way of externally monitoring input, choose a higher Samples Per Buffer setting. Depending on your computer's CPU speed, you might find that settings in the middle work best.

The Samples Per Buffer setting also impacts how quickly your audio software will respond when you begin playback, although not by amounts that are very noticeable. Lowering the Samples Per Buffer will make your software respond faster; raising the Samples Per Buffer will make it a little bit slower, but barely enough to notice.

Monitoring live inputs without plug-in effects
As mentioned earlier, CueMix Console allows you to monitor dry, unprocessed live inputs with no delay at all. For complete details, see chapter 11, “Reducing Monitoring Latency” (page 85).

Enable Pedal
Check the Enable Pedal option if a foot switch is connected to the 896HD and you would like to trigger recording punch in/out (or other software functions) with it. Use the Set buttons to determine what keystroke is triggered by the pedal-up and pedal-down positions. You can assign the pedal to any two keystrokes you wish. (You are not restricted to punch in/out.)

Interface menu
If you are operating multiple MOTU FireWire audio interfaces, use this menu to access their settings. When you choose an interface from this menu, its settings are displayed in the window.

Disable
This check box, when checked, takes the interface currently chosen in the Interface menu off line. When it is off line, its inputs and outputs are not available to audio applications, and bandwidth on the FireWire bus is relinquished, freeing it up for other devices.

Optical input/output
The Optical input and Optical output settings let you choose between ADAT (‘lightpipe’) or OFF. Turning it off frees up FireWire bandwidth. In other words, it opens up resources on the FireWire bus for other devices connected via FireWire.

Phones
The Phones setting lets you choose what you will hear from the headphone jack. Choose Main Outs if you’d like the headphone output to match the main outs. Choose Phones if you would like the headphones to serve as their own independent output, which you can access as an independent output destination in your host audio software and as an output destination for the four on-board CueMix DSP mix busses.
At the 4x sample rates (176.4 and 192kHz), the headphone output can be assigned to any analog output pair or the Phones setting, as described above. But at the 4x sample rates, the Phones output is not available as an output destination for software on the computer. Instead, it is only available as a destination for the two CueMix DSP mixes. In other words, it can only take CueMix inputs.

Sample Rate Conversion
This option lets you control AES/EBU sample rate conversion. Sample rate conversion is available when the 896HD is operating at the 1x sample rates (44.1 and 48kHz) or the 2x sample rates (88.2 or 96kHz). AES/EBU is disabled entirely at the 4x sample rates (176.4 and 192kHz). Each option is explained below.

None
No sample rate conversion occurs. Both the AES/EBU input and output match the sample rate of the 896HD’s system clock.

AES In
The AES/EBU input locks to the sample rate of the input signal (whatever it happens to be) and converts it to the 896HD system clock rate. The Rate Conversion LEDs on the 896HD front panel indicate the incoming sample rate and that rate conversion is occurring.

AES Out slave to AES in
To make the AES/EBU output sample rate match the sample rate currently being received by the 896HD’s AES/EBU input, choose AES Out slave to AES in. This setting requires a connection to the 896HD’s AES/EBU input from a device that is transmitting an AES/EBU clock signal.

When you are using the AES/EBU input as a clock source for sample rate conversion on the AES/EBU output, you cannot use the AES/EBU input for audio input.

AES Out x 2 / AES Out ÷ 2
Choose one of these sample rates when the desired AES/EBU output rate needs to be twice the 896HD system clock rate (when the system clock is at either 44.1 or 48 kHz) or half the system clock rate (when the system clock is at 88.2 or 96 kHz). Either way, the AES/EBU output remains resolved to the 896HD system clock. For further details about this option, see “Syncing AES/EBU devices” on page 26.

Programmable Meters
This option lets you choose which bank you wish to monitor with the eight programmable meters on the MOTU 896HD front panel. Your choices are: Analog Out, ADAT In or ADAT Out.

AES/EBU Meters
This option lets you choose to monitor either AES/EBU input or output with the programmable AES/EBU meters on the MOTU 896HD front panel.

Clip Hold Time
The Clip Hold Time option controls how long the top red LED remains illuminated after clipping occurs (see Figure 6-2 below).

Be careful when both the 896HD’s AES/EBU input and output are connected to the same external device: this option is likely to create a clock loop.

☛ When you are using the AES/EBU input as a clock source for sample rate conversion on the AES/EBU output, you cannot use the AES/EBU input for audio input.

AES Out x 2 / AES Out ÷ 2
Choose one of these sample rates when the desired AES/EBU output rate needs to be twice the 896HD system clock rate (when the system clock is at either 44.1 or 48 kHz) or half the system clock rate (when the system clock is at 88.2 or 96 kHz). Either way, the AES/EBU output remains resolved to the 896HD system clock. For further details about this option, see “Syncing AES/EBU devices” on page 26.

Programmable Meters
This option lets you choose which bank you wish to monitor with the eight programmable meters on the MOTU 896HD front panel. Your choices are: Analog Out, ADAT In or ADAT Out.

AES/EBU Meters
This option lets you choose to monitor either AES/EBU input or output with the programmable AES/EBU meters on the MOTU 896HD front panel.

Clip Hold Time
The Clip Hold Time option controls how long the top red LED remains illuminated after clipping occurs (see Figure 6-2 below).

Be careful when both the 896HD’s AES/EBU input and output are connected to the same external device: this option is likely to create a clock loop.

☛ When you are using the AES/EBU input as a clock source for sample rate conversion on the AES/EBU output, you cannot use the AES/EBU input for audio input.

AES Out x 2 / AES Out ÷ 2
Choose one of these sample rates when the desired AES/EBU output rate needs to be twice the 896HD system clock rate (when the system clock is at either 44.1 or 48 kHz) or half the system clock rate (when the system clock is at 88.2 or 96 kHz). Either way, the AES/EBU output remains resolved to the 896HD system clock. For further details about this option, see “Syncing AES/EBU devices” on page 26.

Programmable Meters
This option lets you choose which bank you wish to monitor with the eight programmable meters on the MOTU 896HD front panel. Your choices are: Analog Out, ADAT In or ADAT Out.

AES/EBU Meters
This option lets you choose to monitor either AES/EBU input or output with the programmable AES/EBU meters on the MOTU 896HD front panel.

Clip Hold Time
The Clip Hold Time option controls how long the top red LED remains illuminated after clipping occurs (see Figure 6-2 below).

If you want the ability to clear the LED manually from your host audio software or the Cue Mix Console, Choose Infinite from the Clip Hold Time menu. In Digital Performer or AudioDesk, you can clear the 896HD clip LEDs by choosing Audio menu>Clear All Clipping Indicators.
**Peak Hold Time**
The 896HD front-panel level meters support standard peak/hold metering, where the LED for the highest level recently measured on the channel remains illuminated for a brief period of time while the rest of the LEDs below it remain fully dynamic. The Peak Hold Time controls how long the peak-hold LED remain illuminated before going dark again.

**Word Out**
The Word Out menu appears when the 896HD is operating at a 2x sample rate (88.2 or 96kHz) or 4x sample rate (176.4 or 192kHz). This menu lets you set the word clock output either to match the current sample rate (System Clock) or force it to the corresponding 1x rate (either 44.1 or 48kHz). For example, if the 896HD were operating at 176.4kHz, choosing the Force 44.1/48kHz option would produce word clock output at 44.1kHz.

**IF 896HD SETTINGS ARE GRAYED OUT**
If the MOTU FireWire driver is currently in use by an audio program (or Sound Manager), some of its settings cannot be changed and are therefore grayed out in the MOTU FireWire Control Panel menus. (Settings that cannot be changed are ones on which audio applications continuously depend for smooth, error free operation.) If you find that a MOTU FireWire Control Panel setting that you wish to change is grayed out, simply quit all 896HD-compatible audio programs (which may include Sound Manager-compatible programs, too, if you are using the 896HD with Sound Manager). Once you have quit all applications, all MOTU FireWire Control Panel settings will be available (not grayed out).
OVERVIEW
This chapter provides a brief overview of Digital Performer's basic I/O and synchronization operation with the 896HD hardware. This chapter covers both DP3 with Mac OS 9 and DP4 with Mac OS X.

Setting up your system ........................................ 53
The 896HD settings ............................................ 53
Be sure you have enough voices ....................... 55
Trimming the analog inputs .............................. 56
Working with 896HD inputs and outputs ........... 56
24-bit operation .............................................. 56
Fine-tuning I/O timing ..................................... 56
Synchronization .............................................. 57
MIDI Machine Control (MMC) ......................... 58
Processing live inputs with plug-ins ................. 58
Using a foot switch ........................................... 58
Exchanging projects with AudioDesk ............... 58
Sound Manager and Digital Performer (OS 9 only) .. 58

SETTING UP YOUR SYSTEM
As described in chapter 4, “Installing the 896HD Macintosh Software” (page 33), the Digital Performer and MOTU 896HD software installers will properly install and update everything for you.

If you are using a MIDI Timepiece AV or Digital Timepiece for synchronization, be sure they are present in Audio MIDI setup (or FreeMIDI Setup under Mac OS 9).

THE 896HD SETTINGS
896HD settings in Mac OS 9
In Mac OS 9, the 896HD settings can be accessed by choosing MOTU Audio System options>Configure Hardware Driver from the Basics menu. This is where you choose the 896HD as your audio input output device. Once you’ve done so, you should see the 896HD settings as shown below in Figure 7-1.
**896HD settings in Mac OS X**

In Mac OS X, choose the 896HD as your audio input/output device by choosing `MOTU Audio System options` > `Configure Hardware Driver` from the Setup menu. This window shows some of the 896HD settings, such as sample rate and clock source, but to access all of the 896HD settings, open the MOTU FireWire Audio Console, as shown in Figure 5-1 on page 38.

For complete details about the 896HD settings, see chapter 5, “MOTU FireWire Audio Console (Mac OS X)” (page 37) or chapter 6, “MOTU FireWire Control Panel (Mac OS 9)” (page 45). The following sections provide a brief explanation of each 896HD setting for use with Digital Performer.

**Sample rate**

Choose the desired overall sample rate for the 896HD system and Digital Performer. Newly recorded audio in Digital Performer will have this sample rate. Imported audio or soundbites in
existing files that do not match this sample rate will be displayed in the Soundbites window with a red ‘X’ on its move handle to indicate that it cannot be played. Use the commands in the Soundbites window mini-menu to sample rate convert the files, if desired.

Before running the 896HD at the 4x sample rates, see “Operation at 4x sample rates (176.4 or 192kHz)” on page 38.

Clock Source
This setting is very important because it determines which audio clock the 896HD will follow.

If you do not have any digital audio connections to your 896HD (you are using the analog inputs and outputs only), and you will not be slaving Digital Performer to an external clock source, choose Internal.

If you are slaving the 896HD to the ADAT Sync or Word Clock input connector, choose ADAT 9-pin or Word Clock In, respectively.

For information about the other clock source settings, see “Clock Source” on page 39.

If you have digital audio devices connected to the 896HD, see “Making sync connections” on page 19.

Buffer Size (OS X) / Samples Per Buffer (OS 9)
The Buffer Size setting (Samples Per Buffer under Mac OS 9) can be used to reduce the delay — or monitoring latency — that you hear when live audio is patched through your 896HD hardware and Digital Performer. For example, you might have MIDI instruments, samplers, microphones, and so on connected to the analog inputs of the 896HD. If so, you will often be mixing their live input with audio material recorded in Digital Performer. See chapter 11, “Reducing Monitoring Latency” (page 85) for complete details.

Optical input and output
To make the 896HD optical input or output available in Digital Performer, turn them on in the optical input and/or output menu. If you won’t be using the optical connectors, turn them off.

Phones
This 896HD setting lets you choose what you’ll hear from the headphone jack. For example, if you choose Main Outs, the headphones will duplicate the main outs. Or you can choose any other output pair. If you choose Phones, this setting makes the headphone jack serve as its own independent output pair (except when running at 176.4 or 192kHz). As a result, you’ll see Phones 1-2 as an additional audio destination in Digital Performer’s audio output menus.

BE SURE YOU HAVE ENOUGH VOICES
Go to the Setup menu (Basics menu under Mac OS 9) and choose MOTU Audio System Options>Configure Studio Size. Then check to make sure you have enough mono and stereo audio voices to cover the 18 channels of input and 22 channels of output provided by your 896HD — although the number of channels may depend on how your 896HD is configured:

- 12 channels for analog I/O (including the headphone out)
- 2 channels for AES/EBU
- Zero or 8 channels for optical, depending on whether you have optical turned off or set to ADAT optical

For example, if you are using analog only, the 896HD requires a minimum of 12 voices (for 12 channels of output). If you are using analog and AES/EBU, you need 14 voices.
As another example, if you are using analog, AES/EBU and ADAT optical, you need 22 voices (the maximum number of simultaneous output channels provided by the 896HD).

TRIMMING THE ANALOG INPUTS
The 896HD analog inputs provide trim knobs on the front panel. To calibrate an audio input:

1. Record-enable a track in Digital Performer.
2. Choose the desired 896HD input for the track.
3. Open the Audio Monitor window.
4. As you feed signal to the input, adjust the input’s corresponding trim knob on the front panel of the 896HD until peaks in the level meter are as high as possible without clipping (hitting zero dB).

WORKING WITH 896HD INPUTS AND OUTPUTS
Once you’ve enabled the MOTU FireWire Audio driver as explained earlier in “The 896HD settings” on page 53, 896HD audio inputs and outputs will appear in Digital Performer’s audio input and output menus. If you don’t see the optical inputs and/or outputs, check the MOTU FireWire Audio Console to make sure they are turned on and set to the format you require. If you don’t plan to use the optical input or output, turn it off to conserve computer bandwidth.

Phones 1-2
If you’ve chosen to treat the 896HD headphones as an independent output, you’ll see Phones 1-2 in Digital Performer’s output menus. Audio tracks assigned to this output pair will be heard on the headphone jack only. For further explanation, see “Phones” on page 41.

Mix1 1-2
In Digital Performer’s audio input menus, you’ll see an 896HD input called Mix1 1-2. This input source delivers the output of CueMix DSP “MIX1” (the first mix bus of the four on-board no-latency monitor mixes in the 896HD) to your computer. This input serves, for example, as a convenient way for you to record the 896HD’s MIX1 monitor mix into Digital Performer (for reference and archiving purposes). Further, if you are sending audio from Digital Performer to the same output pair as MIX1, you can choose to either include or exclude the audio from the computer in the MIX1 stream being sent to Digital Performer. For details on how to do this, see “Mix1 Return Includes Computer” on page 96.

The Mix1 1-2 input is not available at the 4x sample rates (176.4 or 192kHz).

Warning: the Mix1 1-2 input can cause feedback loops! DO NOT assign this input to a track that shares the same 896HD output pair as MIX1.

24-BIT OPERATION
Your 896HD hardware fully supports Digital Performer’s 24-bit recording capabilities, including both analog and digital 24-bit recording. If you would like to record and play back 24-bit audio files, go to the Setup menu (Basics menu under OS 9), choose MOTU Audio System options>Configure Sample Format, and choose 24-bit recording as the sample format. This setting is saved with the Digital Performer project.

FINE-TUNING I/O TIMING
The 896HD has the ability to be sample accurate. This means that when you transfer audio between Digital Performer and an ADAT (or other ADAT-sync compatible recorder), for example, you can record the audio back and forth as many times as you want between them and it will remain exactly at its original sample location (unless you move it in Digital Performer, of course).
Occasionally, you may encounter a situation in which you observe a slight offset of one sample — or maybe a few — caused by inherent latencies in the devices you are using with the 896HD. Usually, these offsets will be consistent, and you can compensate for them in Digital Performer. To do so, choose MOTU Audio System Options > Fine-tune Audio I/O Timing from the Setup menu (Basics menu under Mac OS 9) as shown in Figure 7-3.

![Fine-tune Audio I/O Timing](image)

**Figure 7-3: Fine-tuning the timing of audio playback and recording.**

### SYNCHRONIZATION

Digital Performer can run under its own transport control or slave to an external sync source, such as SMPTE time code or ADAT sync (sample address).  

#### Running DP under its own transport control

If you do not need to synchronize Digital Performer with time code or another recording device, such as a tape deck, just leave the Slave to External Sync command in the Studio menu (Basics menu under Mac OS 9) unchecked. However, even though Digital Performer is not slaving to external sync, you still need to be concerned with the synchronization of the 896HD’s digital audio clock with other devices connected to it digitally (if any). For example, if you have a digital mixer connected to the 896HD via an ADAT optical lightpipe cable, you need to make sure that their audio clocks are phase-locked. For details, see “Syncing optical devices” on page 25 and “Making sync connections” on page 19. If you don’t have any digital audio devices connected to the 896HD, digital audio phase-lock does not apply to you.

### Resolving DP and the 896HD to word clock, video and/or SMPTE time code

To resolve your Digital Performer/896HD system to word clock, video and/or SMPTE time code using an additional synchronization device, use the setup shown in “Syncing word clock devices” on page 29 or “Syncing to video and/or SMPTE time code” on page 24.

Choose Receive Sync from the Setup menu (Basics menu under Mac OS 9) and choose the MTC (MIDI Time Code) option. Then make sure that the Slave to External Sync command in the Studio menu (Basics menu under Mac OS 9) is checked. To ensure that your audio tracks don’t drift out of sync with your MIDI tracks — or time code, use a hardware synchronizer like the MIDI Timepiece AV or Digital Timepiece to resolve the 896HD hardware as well, as shown in Figure 3-23 on page 29. A digital audio synchronizer is required for drift-free SMPTE/MIDI time code sync. Make sure the Clock Source setting in the MOTU FireWire Audio Console window has the appropriate setting for locking the 896HD to the synchronizer. For example, in Figure 3-23 on page 29, word clock is being used to resolve the 896HD, so the Clock Source setting is **Word Clock In**.

If you have an ADAT sync compatible device, don’t use SMPTE time code. Instead, use sample-accurate sync as described in the next section.

### Sample-accurate sync to ADAT and Tascam

Together, Digital Performer and the 896HD provide you with sample-accurate transfers with ADATs, Alesis recorders and any other devices that support standard ADAT sample address (**ADAT Sync**).
Similarly, with the help of a MOTU Digital Timepiece, Digital Performer and a 896HD can perform sample-accurate transfers with Tascam digital recorders.

A sample-accurate transfer is one in which the original location of the audio is preserved in the transfer, down to the sample.

For details on how to set up sample-accurate sync, see “Sample-accurate sync” on page 21. Be sure to choose the Sample Accurate Sync option in Digital Performer’s Receive Sync dialog, and make sure that the Slave to External Sync command is checked, too.

To control the transports of everything together from Digital Performer, see the next section.

MIDI MACHINE CONTROL (MMC)

If you have ADATs and a MMC-compatible ADAT synchronizer like the MIDI Timepiece AV or Digital Timepiece, you can control everything from your computer screen with Digital Performer’s transport controls and cueing features (like Markers, the playback wiper, etc.)

Similarly, if you have Tascam recorders and a MOTU Digital Timepiece (or other MMC-compatible Tascam synchronizer), can control all of your Tascam decks (in ABS time) in a similar fashion from Digital Performer.

See the MIDI Machine Control chapter in your MIDI Timepiece AV or Digital Timepiece manual for details on how to set this up.

PROCESSING LIVE INPUTS WITH PLUG-INS

If you patch a live input (such as a MIDI synthesizer) through a plug-in effect in Digital Performer, you might hear a slight delay. There are several ways to reduce this delay. For details, see chapter 11, “Reducing Monitoring Latency” (page 85).

USING A FOOT SWITCH

Use a foot switch connected to the 896HD to trigger recording punch-in and punch-out, or any other feature in Digital Performer that is assigned to a computer keystroke. By default, the foot switch triggers the 3 key on the computer keypad (which toggles Digital Performer’s record button.) To trigger a different set of keystrokes with the foot switch, visit the MOTU FireWire Audio Console. (See “Enable Pedal” on page 43.)

EXCHANGING PROJECTS WITH AUDIODESK

AudioDesk Version 1 projects

Digital Performer (Version 2.6 or later) can exchange files with AudioDesk (Version 1). For example, you can transfer a file from Digital Performer to AudioDesk, and back again. Just use Save As in Digital Performer’s File menu and choose the AudioDesk file format. To open AudioDesk Version 1 files in Digital Performer, just use the Open command. (No conversion is required beforehand in AudioDesk.)

If you have an earlier version of Digital Performer (2.5 or earlier), you can open your Digital Performer files in AudioDesk (with the Open command in the File menu), but Digital Performer 2.5 or earlier cannot open AudioDesk files.

AudioDesk Version 2 projects

If you are running Digital Performer 4 on Mac OS X, you can exchange files with AudioDesk Version 2. Just use Save As in Digital Performer’s File menu and choose the AudioDesk 1.0 file format. To open AudioDesk Version 2 (or Version 1) files in DP4, just use the Open command. (No conversion is required beforehand in AudioDesk.)

SOUND MANAGER AND DIGITAL PERFORMER (OS 9 ONLY)

Digital Performer includes a Mac OS 9 MOTU Audio System plug-in called AudioTap that allows you to route any Sound Manager audio into Digital Performer’s mixing environment. From there, you
can route it to your 896HD interface via any of Digital Performer’s extensive audio routing features. For details, consult your Digital Performer documentation.
OVERVIEW
This chapter provides a brief overview of AudioDesk’s basic I/O and synchronization operation with the 896HD hardware. For complete information about all of AudioDesk’s powerful workstation features, see the AudioDesk manual included with your 896HD system. This chapter covers both AudioDesk Version 1 with Mac OS 9 and AudioDesk Version 2 with Mac OS X.

SETTING UP YOUR SYSTEM
As described in chapter 4, “Installing the 896HD Macintosh Software” (page 33), the MOTU FireWire Audio software installer will properly install everything for you, including AudioDesk.

If you will be using AudioDesk’s MIDI Machine Control (MMC) or MIDI Time Code sync features, and you are using Mac OS 9, FreeMIDI must be installed. (You can install FreeMIDI from the MOTU FireWire installer CD.) Under Mac OS X, the CoreMIDI driver is automatically installed for you as part of the “Easy Install” package.

If you are using a MIDI Timepiece AV or Digital Timepiece for synchronization, be sure they are present in Audio MIDI setup (or FreeMIDI Setup under Mac OS 9).
THE 896HD SETTINGS

896HD settings in Mac OS 9
In Mac OS 9, the 896HD settings can be accessed by choosing MOTU Audio System options>Configure Hardware Driver from the Basics menu. This is where you choose the 896HD as your audio input output device. Once you’ve done so, you should see the 896HD settings as shown below in Figure 8-1.

896HD settings in Mac OS X
In Mac OS X, choose the 896HD as your audio input output device by choosing MOTU Audio System options>Configure Hardware Driver from the Setup menu. This window shows some of the 896HD settings, such as sample rate and clock source, but to access all of the 896HD settings, open the MOTU FireWire Audio Console, as shown in Figure 5-1 on page 38.

Figure 8-1: The 896HD settings.

Figure 8-2: Under Mac OS X, choose Setup menu> Configure Audio System> Configure Hardware Driver to open the dialog shown above and access the 896HD CoreAudio driver. To access the rest of the 896HD settings, open the MOTU FireWire Audio Console.
For complete details about the 896HD settings, see chapter 5, “MOTU FireWire Audio Console (Mac OS X)” (page 37) or chapter 6, “MOTU FireWire Control Panel (Mac OS 9)” (page 45). The following sections provide a brief explanation of each 896HD setting for use with AudioDesk.

Sample rate
Choose the desired overall sample rate for the 896HD system and AudioDesk. Newly recorded audio in AudioDesk will have this sample rate. Imported audio or soundbites in existing files that do not match this sample rate will be displayed in the Soundbites window with a red ‘X’ on its move handle to indicate that it cannot be played. Use the commands in the Soundbites window mini-menu to sample rate convert the files, if desired.

Before running the 896HD at the 4x sample rates, see “Operation at 4x sample rates (176.4 or 192kHz)” on page 38.

Clock Source
This setting is very important because it determines which audio clock the 896HD will follow.

If you do not have any digital audio connections to your 896HD (you are using the analog inputs and outputs only), and you will not be slaving AudioDesk to an external clock source, choose Internal.

If you are slaving the 896HD to the ADAT Sync or Word Clock input connector, choose ADAT 9-pin or Word Clock In, respectively.

For information about the other clock source settings, see “Clock Source” on page 39.

If you have digital audio devices connected to the 896HD, see “Making sync connections” on page 19.

Buffer Size (OS X) / Samples Per Buffer (OS 9)
The Buffer Size setting (Samples Per Buffer under Mac OS 9) can be used to reduce the delay — or monitoring latency — that you hear when live audio is patched through your 896HD hardware and AudioDesk. For example, you might have MIDI instruments, samplers, microphones, and so on connected to the analog inputs of the 896HD. If so, you will often be mixing their live input with audio material recorded in AudioDesk. See chapter 11, “Reducing Monitoring Latency” (page 85) for complete details.

Optical input and output
To make the 896HD optical input or output available in AudioDesk, turn them on in the optical input and/or output menu. If you won’t be using the optical connectors, turn them off.

Phones
This 896HD setting lets you choose what you’ll hear from the headphone jack. For example, if you choose Main Outs, the headphones will duplicate the main outs. Or you can choose any other output pair. If you choose Phones, this setting makes the headphone jack serve as its own independent output pair (except when running at 176.4 or 192kHz). As a result, you’ll see Phones 1-2 as an additional audio destination in AudioDesk’s audio output menus.

BE SURE YOU HAVE ENOUGH VOICES
Go to the Setup menu (Basics menu under Mac OS 9) and choose MOTU Audio System Options>Configure Studio Size. Then check to make sure you have enough mono and stereo audio voices to cover the 18 channels of input and 22 channels of output provided by your 896HD — although the number of channels may depend on how your 896HD is configured:

- 12 channels for analog I/O (including the headphone out)
- 2 channels for AES/EBU
Zero or 8 channels for optical, depending on whether you have optical turned off or set to ADAT optical.

For example, if you are using analog only, the 896HD requires a minimum of 12 voices (for 12 channels of output). If you are using analog and AES/EBU, you need 14 voices.

As another example, if you are using analog, AES/EBU and ADAT optical, you need 22 voices (the maximum number of simultaneous output channels provided by the 896HD).

TRIMMING THE ANALOG INPUTS

The 896HD analog inputs provide trim knobs on the front panel. To calibrate an audio input:

1. Record-enable a track in AudioDesk.

2. Choose the desired 896HD input for the track.

3. Open the Audio Monitor window.

4. As you feed signal to the input, adjust the input's corresponding trim knob on the front panel of the 896HD until peaks in the level meter are as high as possible without clipping (hitting zero dB).

WORKING WITH 896HD INPUTS AND OUTPUTS

Once you've enabled the MOTU FireWire Audio driver as explained earlier in “The 896HD settings” on page 62, 896HD audio inputs and outputs will appear in AudioDesk's audio input and output menus. If you don't see the optical inputs and/or outputs, check the MOTU FireWire Audio Console to make sure they are turned on and set to the format you require. If you don't plan to use the optical input or output, turn it off to conserve computer bandwidth.

Phones 1-2

If you've chosen to treat the 896HD headphones as an independent output, you'll see Phones 1-2 in AudioDesk's output menus. Audio tracks assigned to this output pair will be heard on the headphone jack only. For further explanation, see “Phones” on page 63.

Mix1 1-2

In AudioDesk's audio input menus, you'll see an 896HD input called Mix 1-2. This input source delivers the output of CueMix DSP "MIX1" (the first mix bus of the four on-board no-latency monitor mixes in the 896HD) to your computer. This input serves, for example, as a convenient way for you to record the 896HD's MIX1 monitor mix into AudioDesk (for reference and archiving purposes). Further, if you are sending audio from AudioDesk to the same output pair as MIX1, you can choose to either include or exclude the audio from the computer in the MIX1 stream being sent to AudioDesk. For details on how to do this, see “Mix1 Return Includes Computer” on page 96.

The Mix1 1-2 input is not available at the 4x sample rates (176.4 or 192kHz).

Warning: the Mix1 1-2 input can cause feedback loops! DO NOT assign this input to a track that shares the same 896HD output pair as MIX1.

24-BIT OPERATION

Your 896HD hardware fully supports AudioDesk's 24-bit recording capabilities, including both analog and digital 24-bit recording. If you would like to record and play back 24-bit audio files, go to the Setup menu (Basics menu under OS 9), choose MOTU Audio System options>Configure Sample Format, and choose 24-bit recording as the sample format. This setting is saved with the AudioDesk project.
FINE-TUNING I/O TIMING
The 896HD has the ability to be sample accurate. This means that when you transfer audio between AudioDesk and an ADAT (or other ADAT-sync compatible recorder), for example, you can record the audio back and forth as many times as you want between them and it will remain exactly at its original sample location (unless you move it in AudioDesk, of course).

Occasionally, you may encounter a situation in which you observe a slight offset of one sample — or maybe a few — caused by inherent latencies in the devices you are using with the 896HD. Usually, these offsets will be consistent, and you can compensate for them in AudioDesk. To do so, choose MOTU Audio System Options > Fine-tune Audio I/O Timing from the Setup menu (Basics menu under Mac OS 9) as shown in Figure 8-3.

SYNCHRONIZATION
AudioDesk can run under its own transport control or slave to an external sync source, such as SMPTE time code or ADAT sync (sample address).

Running AudioDesk under its own transport control
If you do not need to synchronize AudioDesk with time code or another recording device, such as a tape deck, just leave the Slave to External Sync command in the Studio menu (Basics menu under OS 9) unchecked.

However, even though AudioDesk is not slaving to external sync, you still need to be concerned with the synchronization of the 896HD’s digital audio clock with other devices connected to it digitally (if any). For example, if you have a digital mixer connected to the 896HD via an ADAT optical lightpipe cable, you need to make sure that their audio clocks are phase-locked. For details, see “Syncing optical devices” on page 25 and "Making sync connections" on page 19. If you don’t have any digital audio devices connected to the 896HD, digital audio phase-lock does not apply to you.

Resolving AudioDesk and the 896HD to word clock, video and/or SMPTE time code
To resolve your AudioDesk/896HD system to word clock, video and/or SMPTE time code using an additional synchronization device, use the setup shown in “Syncing word clock devices” on page 29 or "Syncing to video and/or SMPTE time code" on page 24.

Choose Receive Sync from the Setup menu (Basics menu under Mac OS 9) and choose the MTC (MIDI Time Code) option. Then make sure that the Slave to External Sync command in the Studio menu (Basics menu under Mac OS 9) is checked. To ensure that your audio tracks don’t drift out of sync with your MIDI tracks — or time code, use a hardware synchronizer like the MIDI Timepiece AV or Digital Timepiece to resolve the 896HD hardware as well, as shown in Figure 3-23 on page 29. A digital audio synchronizer is required for drift-free SMPTE/MIDI time code sync. Make sure the Clock Source setting in the MOTU FireWire Audio Console window has the appropriate setting for locking the 896HD to the synchronizer. For example, in Figure 3-23 on page 29, word clock is being used to resolve the 896HD, so the Clock Source setting is Word Clock In.
If you have an ADAT sync compatible device, don’t use SMPTE time code. Instead, use sample-accurate sync as described in the next section.

**Sample-accurate sync to ADAT and Tascam**

Together, AudioDesk and the 896HD provide you with sample-accurate transfers with ADATs, Alesis recorders and any other devices that support standard ADAT sample address (*ADAT Sync*).

Similarly, with the help of a MOTU Digital Timepiece, AudioDesk and a 896HD can perform sample-accurate transfers with Tascam digital recorders.

A sample-accurate transfer is one in which the original location of the audio is preserved in the transfer, down to the sample.

For details on how to set up sample-accurate sync, see “Sample-accurate sync” on page 21. Be sure to choose the *Sample Accurate Sync* option in AudioDesk’s *Receive Sync* dialog, and make sure that the *Slave to External Sync* command is checked, too.

To control the transports of everything together from AudioDesk, see the next section.

**MIDI MACHINE CONTROL (MMC)**

If you have ADATs and a MMC-compatible ADAT synchronizer like the MIDI Timepiece AV or Digital Timepiece, you can control everything from your computer screen with AudioDesk’s transport controls and cueing features (like Markers, the playback wiper, etc.)

Similarly, if you have Tascam recorders and a MOTU Digital Timepiece (or other MMC-compatible Tascam synchronizer), can control all of your Tascam decks (in ABS time) in a similar fashion from AudioDesk.

See the MIDI Machine Control chapter in your MIDI Timepiece AV or Digital Timepiece manual for details on how to set this up.

**PROCESSING LIVE INPUTS THROUGH PLUG-INS**

If you patch a live input (such as microphone) through a plug-in effect in AudioDesk, you might hear a slight delay. There are several ways to reduce this delay. For details, see chapter 11, “Reducing Monitoring Latency” (page 85).

**USING A FOOT SWITCH**

Use a foot switch connected to the 896HD to trigger recording punch-in and punch-out, or any other feature in AudioDesk that is assigned to a computer keystroke. By default, the foot switch triggers the 3 key on the computer keypad (which toggles AudioDesk’s record button.) To trigger a different set of keystrokes with the foot switch, visit the MOTU FireWire Audio Console. (See “Enable Pedal” on page 43.)

**EXCHANGING PROJECTS WITH DIGITAL PERFORMER**

**AudioDesk Version 1 projects**

Digital Performer (Version 2.6 or later) can exchange files with AudioDesk (Version 1). For example, you can transfer a file from Digital Performer to AudioDesk, and back again. Just use *Save As* in Digital Performer’s File menu and choose the *AudioDesk* file format. To open AudioDesk Version 1 files in Digital Performer, just use the Open command. (No conversion is required beforehand in AudioDesk.)

If you have an earlier version of Digital Performer (2.5 or earlier), you can open your Digital Performer files in AudioDesk (with the Open command in the File menu), but Digital Performer 2.5 or earlier cannot open AudioDesk files.
AudioDesk Version 2 projects
If you are running Digital Performer 4 on Mac OS X, you can exchange files with AudioDesk Version 2. Just use Save As in Digital Performer's File menu and choose the AudioDesk 1.0 file format. To open AudioDesk Version 2 (or Version 1) files in DP4, just use the Open command. (No conversion is required beforehand in AudioDesk.)

AUDIODESK AND MIDI SEQUENCING
AudioDesk can play audio as a background application, allowing you to run a sequencer at the same time in the foreground. However, there is no way to continuously synchronize — or resolve — a sequencer with AudioDesk, so the two programs will eventually drift out of sync, even if you manage to start them at the same time. If you'd like to do integrated MIDI sequencing, your best bet is Digital Performer, which offers pretty much all of the same features as AudioDesk, along with powerful, state-of-the-art MIDI sequencing. Talk to your authorized MOTU dealer for details about upgrading from AudioDesk to Digital Performer.
CHAPTER 9 Other Mac OS X Audio Software

OVERVIEW
The 896HD provides multichannel audio and MIDI input and output for all Mac OS X audio applications. This chapter covers third-party audio applications. For information about running Digital Performer or AudioDesk under Mac OS X, refer to chapter 7, “Digital Performer” (page 53) or chapter 8, “AudioDesk” (page 61).

Installing the 896HD Mac OS X drivers ............... 69
Run the MOTU FireWire Audio Console .......... 69
Choosing the MOTU FireWire CoreAudio driver .... 70
Audio Input and output names ..................... 71
Number of channels ............................ 72
Trimming the analog inputs ........................ 73
Processing live inputs with plug-ins ............... 73
Using a foot switch ............................ 73
Synchronization .............................. 73

INSTALLING THE 896HD MAC OS X DRIVERS
To install the 896HD's Mac OS X audio and MIDI drivers, just run the installer on the MOTU FireWire Audio installer CD as detailed in chapter 4, "Installing the 896HD Macintosh Software" (page 33).

RUN THE MOTU FIREWIRE AUDIO CONSOLE
Before you run your host audio software, launch the MOTU FireWire Audio Console to configure your 896HD hardware. The MOTU FireWire Audio Console lets you configure your audio interface, and it lets you enable the desired inputs and outputs. Only enabled inputs and outputs will be available to your software, so this is an important step. For complete details see chapter 5, "MOTU FireWire Audio Console (Mac OS X)" (page 37).

Figure 9-1: The MOTU FireWire Audio Console.

For complete details about the 896HD settings, see chapter 5, “MOTU FireWire Audio Console (Mac OS X)” (page 37). The following sections provide a brief explanation of each 896HD setting.

Sample rate
Choose the desired overall sample rate for the 896HD system and your host audio software. Newly recorded audio will have this sample rate.

Clock Source
This setting is very important because it determines which audio clock the 896HD will follow.
If you do not have any digital audio connections to your 896HD (you are using the analog inputs and outputs only), and you will not be slaving your host software to an external clock source, choose Internal.

If you are slaving the 896HD to the ADAT Sync or Word Clock input connector, choose ADAT 9-pin or Word Clock In, respectively.

For information about the other clock source settings, see “Clock Source” on page 39.

If you have digital audio devices connected to the 896HD, see “Making sync connections” on page 19.

**Optical input and output**

To make the 896HD optical input or output available in your host software, turn them on in the optical input and/or output menu. If you won’t be using the optical connectors, turn them off.

**Phones**

This 896HD setting lets you choose what you’ll hear from the headphone jack. For example, if you choose Main Outs, the headphones will duplicate the main outs. Or you can choose any other output pair. If you choose Phones, this setting makes the headphone jack serve as its own independent output pair (except when running at 176.4 or 192kHz). As a result, you’ll see Phones 1-2 as an additional audio destination in your host audio software’s audio output menus.

**CHOOSING THE MOTU FIREWIRE COREAUDIO DRIVER**

Once you’ve made the preparations described so far in this chapter, you’re ready to run your audio software and enable the MOTU 896HD CoreAudio driver. Check the audio system or audio hardware configuration window in your software. There will be a menu there that lets you choose among various drivers that may be in your system. Choose the MOTU 896HD driver from this menu.

**Cubase SX and Nuendo**

Go to the Devices menu and choose Device Setup. Choose the MOTU 896HD CoreAudio driver from the “ASIO Driver” menu as shown below. Activate the inputs and outputs within Cubase or Nuendo as usual. For information about the Audio Buffer Size setting, see “Adjusting buffer settings under Mac OS X” on page 87.

**Logic Audio**

In Logic audio, go to the Preferences window, choose Audio Driver from the menu, and expand the CoreAudio item as shown below. For information about the I/O Buffer Size setting, see “Adjusting buffer settings under Mac OS X” on page 87.
Other audio software

For other audio applications, the procedure is similar to that shown above for Cubase and Logic. Consult your owner’s manual for further information.

**Figure 9-3: Enabling the 896HD in Logic Audio.**

**Figure 9-4: Some applications number the 896HD inputs and outputs, but don’t display which outputs they refer to.**

**AUDIO INPUT AND OUTPUT NAMES**

The 896HD CoreAudio driver supplies text string labels for its inputs and outputs to clearly identify each one, but some applications do not display these labels. For example, in Cubase SX, the 896HD outputs are numbered like this:
Most programs will likely address this issue in future updates. In the meantime, here is how you can identify each input and output. Inputs are always listed in the same order as follows:

<table>
<thead>
<tr>
<th>Input</th>
<th>Channels</th>
<th>List position</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog</td>
<td>8</td>
<td>1-8</td>
<td></td>
</tr>
<tr>
<td>AES/EBU</td>
<td>2</td>
<td>9-10</td>
<td></td>
</tr>
<tr>
<td>Mix1</td>
<td>2</td>
<td>11-12</td>
<td>See “The ‘Mix1’ input pair” below.</td>
</tr>
<tr>
<td>Optical</td>
<td>8 @ 44.1/48kHz 4 @ 88.2/96kHz 13-20 13-16</td>
<td>If the optical bank is set to None, then no optical inputs are displayed.</td>
<td></td>
</tr>
</tbody>
</table>

Outputs are similarly listed in the same order as follows:

<table>
<thead>
<tr>
<th>Output</th>
<th>Channels</th>
<th>List position</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main outs</td>
<td>2</td>
<td>1-2</td>
<td></td>
</tr>
<tr>
<td>Analog</td>
<td>8</td>
<td>3-10</td>
<td></td>
</tr>
<tr>
<td>AES/EBU</td>
<td>2</td>
<td>11-12</td>
<td></td>
</tr>
<tr>
<td>Phones</td>
<td>2</td>
<td>13-14</td>
<td>If the phones are assigned to mirror another output pair (such as the main outs), they won’t be listed separately.</td>
</tr>
<tr>
<td>Optical</td>
<td>8 @ 44.1/48kHz 4 @ 88.2/96kHz 15-22 15-18</td>
<td>If the phones are mirroring, then subtract 2. If the optical bank is set to None, then no optical outputs are displayed.</td>
<td></td>
</tr>
</tbody>
</table>

As an example, the AES/EBU inputs will always be listed as inputs 9-10. As another example, optical output channels 1-2 will be listed as channels 15-16, unless the phones are mirroring the main outs (or another output), in which case optical outputs 1-2 would be listed as channels 13-14.

The ‘Mix1’ input pair
The Mix1 input pair delivers the output of CueMix DSP “MIX1” (the first mix bus of the four on-board no-latency monitor mixes in the 896HD) to your computer. This input serves, for example, as a convenient way for you to record the 896HD’s MIX1 monitor mix into your host audio software (for reference and archiving purposes). Further, if you are sending audio from your host audio software to the same output pair as MIX1, you can choose to either include or exclude the audio from the computer in the MIX1 stream being sent to the computer. For details on how to do this, see “Mix1 Return Includes Computer” on page 96.

The Mix1 1-2 input is not available at the 4x sample rates (176.4 or 192kHz).

| War n i ng: t h e  Mi x1 1-2 i nput can cause feedback loops! DO NOT assign this input to a track that shares the same 896HD output pair as MIX1. |

**NUMBER OF CHANNELS**
If your host audio software requires that you specify the number of audio voices or channels you will be using, be sure to choose enough channels to cover the 18 inputs and 22 outputs provided by your 896HD — although the number of channels may depend on how your 896HD is configured:

- 12 channels for analog I/O (including the headphone out)
- 2 channels for AES/EBU
- Zero or 8 channels for optical, depending on whether you have optical turned off or set to ADAT optical

For example, if you are using analog only, the 896HD requires a minimum of 12 voices (for 12 channels of output). If you are using analog and AES/EBU, you need 14 voices.

As another example, if you are using analog, AES/EBU and ADAT optical, you need 22 voices (the maximum number of simultaneous output channels provided by the 896HD).
TRIMMING THE ANALOG INPUTS
The 896HD analog inputs provide trim knobs on the front panel. To calibrate an audio input:

1. Record-enable a track in your host software.
2. Choose the desired 896HD input for the track.
3. Open the mixer or other window that displays the track's audio input level.
4. As you feed signal to the input, adjust the input's corresponding trim knob on the front panel of the 896HD until peaks in the level meter are as high as possible without clipping (hitting zero dB).

PROCESSING LIVE INPUTS WITH PLUG-INS
If you patch a live input (such as a MIDI synthesizer) through a plug-in effect in your host software, you might hear a slight delay. There are several ways to reduce this delay. For details, see chapter 11, “Reducing Monitoring Latency” (page 85).

USING A FOOT SWITCH
Use a foot switch connected to the 896HD to trigger recording punch-in and punch-out, or any other feature in your host audio software that is assigned to a computer keystroke. By default, the foot switch triggers the 3 key on the computer keypad. To trigger a different set of keystrokes with the foot switch, visit the MOTU FireWire Audio Console. (See “Enable Pedal” on page 43.)

SYNCHRONIZATION
As of this writing, Mac OS X does not allow third-party applications to take advantage of the 896HD’s sample-accurate sync features. Refer to www.motu.com for further developments. However, if most applications that support external sync will be able to support the 896HD’s word clock sync capabilities. Consult chapter 3, “Installing the 896HD Hardware” (page 15) and use the synchronization diagrams in that chapter to synchronize your software and the 896HD to the other components of your system.
OVERVIEW
This chapter explains how to use the 896HD with Mac OS 9 ASIO-compatible audio software such as Cubase and Nuendo. For Mac OS X operation of Cubase, Nuendo, and all other third-party OS X audio software, see chapter 9, “Other Mac OS X Audio Software” (page 69).

The 896HD includes an Mac OS 9 ASIO driver that provides multi-channel I/O and sample-accurate synchronization with Steinberg’s Cubase family of digital audio sequencers, including Cubase VST and Nuendo.

ASIO support is required for 3rd party OS 9 software
Preparation ........................................ 75
Run the MOTU FireWire Audio Console ............. 76
Choosing the MOTU FireWire ASIO driver .......... 77
The ASIO Control Panel button ..................... 78
Number of channels ............................ 78
ASIO Direct monitoring .......................... 78
Other System dialog settings ....................... 79
Activating 896HD inputs .......................... 79
Assigning inputs ................................ 80
Trimming the analog inputs ....................... 80
Assigning outputs ................................ 81
Changing 896HD settings ......................... 82
Processing live inputs with plug-ins ............... 82
Synchronization ................................ 82
MIDI Machine Control (MMC) .................... 84
Using a foot switch ............................. 84
24-bit operation ................................ 84
Monitoring system performance .................. 84

ASIO is an acronym for Audio Streaming Input and Output. The ASIO MOTU FireWire Audio driver allows the 896HD to provide multi-channel audio input and output for any audio application that supports ASIO drivers.

For multi-channel operation with third-party Mac OS 9 audio software, the 896HD requires ASIO compatibility. If your host audio program does not support ASIO, contact the developer.

Sample-accurate sync
The MOTU FireWire Audio ASIO driver supports sample-accurate sync (via the 896HD’s ADAT sync feature) for applications that support it.

Attention: Digital Performer users
Digital Performer supports ASIO, but it also accesses the 896HD directly through the MOTU Audio System, so it is not necessary to use the ASIO driver with Digital Performer.

Attention: Cubase VST users
Cubase VST Version 5 is used for the examples in this chapter. However, there is no significant difference between the Version 5 examples shown and what you see in Version 4. The basic procedures are the same.

Attention: Mac OS 9 Nuendo users
The examples in this chapter show screen shots of Nuendo for Windows, but they are very similar to the Mac OS 9 version.

Attention: Other software users
The 896HD ASIO driver also provides multi-channel I/O with any ASIO-compatible audio software. Cubase is used for the examples in this
chapter. However, the basic procedures are the same and can be easily applied to any ASIO-compatible software. Just follow the general descriptions at the beginning of each main section in this chapter. Consult your software documentation for details about each topic, if necessary.

**PREPARATION**

Before you run Cubase with your 896HD, launch AudioDesk and play back the demo project to make sure that the 896HD hardware software drivers are set up properly. The AudioDesk demo project is located on the 896HD Installer CD. Drag it to your hard drive before opening it in AudioDesk, as your CD drive will be too slow to play the audio.

To make sure that everything is ready for Cubase, install Cubase first (if you haven’t already done so), and then see these chapters before proceeding:

- chapter 3, “Installing the 896HD Hardware” (page 15).
- chapter 4, “Installing the 896HD Macintosh Software” (page 33)
- chapter 8, “AudioDesk” (page 61)

**RUN THE MOTU FIREWIRE AUDIO CONSOLE**

Before you run Cubase, launch the MOTU FireWire Audio Console to configure your 896HD hardware. The MOTU FireWire Audio Console lets you configure your audio interface, and it lets you enable the desired inputs and outputs. Only enabled inputs and outputs will be available to Cubase, so this is an important step. For complete details regarding the MOTU FireWire Audio Console, see chapter 6, “MOTU FireWire Control Panel (Mac OS 9)” (page 45).

For complete details about the 896HD settings, see chapter 6, “MOTU FireWire Control Panel (Mac OS 9)” (page 45). The following sections provide a brief explanation of each 896HD setting for use with Cubase.
Sample rate
Choose the desired overall sample rate for the 896HD system and Cubase. Newly recorded audio in Cubase will have this sample rate. Before running the 896HD at the 4x sample rates, see “Operation at 4x sample rates (176.4 or 192kHz)” on page 38.

Clock Source
This setting is very important because it determines which audio clock the 896HD will follow.

If you do not have any digital audio connections to your 896HD (you are using the analog inputs and outputs only), and you will not be slaving Cubase to an external clock source, choose *Internal*.

If you are slaving the 896HD to the ADAT Sync or Word Clock input connector, choose *ADAT 9-pin* or *Word Clock In*, respectively.

For information about the other clock source settings, see “Clock Source” on page 39.

If you have digital audio devices connected to the 896HD, see “Making sync connections” on page 19.

Samples Per Buffer
The *Samples Per Buffer* setting can be used to reduce the delay — or *monitoring latency* — that you hear when live audio is patched through your 896HD hardware and Cubase. For example, you might have MIDI instruments, samplers, microphones, and so on connected to the analog inputs of the 896HD. If so, you will often be mixing their live input with audio material recorded in Cubase. See chapter 11, “Reducing Monitoring Latency” (page 85) for complete details.

Optical input and output
To make the 896HD optical input or output available in Cubase, turn them on in the optical input and/or output menu. If you won’t be using the optical connectors, turn them off.

Phones
This 896HD setting lets you choose what you’ll hear from the headphone jack. For example, if you choose *Main Outs*, the headphones will duplicate the main outs. Or you can choose any other output pair. If you choose *Phones*, this setting makes the headphone jack serve as its own independent output pair (except when running at 176.4 or 192kHz). As a result, you’ll see *Phones 1-2* as an additional audio destination in Cubase’s audio output menus.

**CHOOSING THE MOTU FIREWIRE ASIO DRIVER**
Once you’ve made the preparations described so far in this chapter, you’re ready to run your audio software and enable the MOTU FireWire ASIO driver. Check the audio system or audio hardware configuration window in your software. There will be a menu there that lets you choose among various ASIO drivers that may be in your system. Choose the MOTU FireWire ASIO driver from this menu.

Cubase VST
To activate the 896HD driver in Cubase VST, choose *Audio Setup>System* from the Options menu, and then choose *MOTU FireWire* from the ASIO device menu. Make the other settings in the dialog as needed for your system and synchronization scenario.

Nuendo
To activate the 896HD driver in Nuendo, go to the Device Setup window, click VST Multitrack and choose *MOTU FireWire ASIO* from the ASIO...
Driver menu as shown below. Make the other settings in the dialog as needed for your system and synchronization scenario.

Cubase

![Cubase VST System Dialog](image)

**Audio System Setup**

- **Audio Performance**
  - Number of Channels: 14
- **Memory per Channel**: 144 KB
- **Disk Block Buffer Size**
  - 32 KB
  - 64 KB
  - 128 KB
  - 256 KB
- **Settings do not take effect until you click APPLY!**

**Monitoring**

- **ASIO Direct Monitor**
- **Record Enable Type**
- **Global Enable**
- **MIDI Sync Reference**
- **MIDI to Audio Delay**
- **Samples**

**Save with Song**

**OK**

**ASIO Device Control Panel**

- **Launch**
- **Latency (Milliseconds)**
  - 73.206
- **Sample Rate**
  - 44100
- **Audio Clock Source**
- **Internal**

**MIDI to Audio Delay**

**Samples**

**Save with Song**

**OK**

**Cubase VST**

**System Dialog**

- **ASIO Device**
  - MOTU FireWire Audio
- **ASIO Device Control Panel**
- **Latency (Milliseconds)**
  - 73.206
- **Sample Rate**
  - 44100
- **Audio Clock Source**
- **Internal**

**MIDI to Audio Delay**

**Samples**

**Save with Song**

**OK**

**Figure 10-3: Activating the 896HD FireWire ASIO driver in Nuendo and Cubase.**

**THE ASIO CONTROL PANEL BUTTON**

The Mac version of Cubase VST does not allow the MOTU FireWire Audio Console to run at the same time as Cubase. Therefore, the ASIO Control Panel button in the System dialog as shown in Figure 10-3 will not launch the MOTU FireWire Audio Console. In the meantime, you can access the MOTU FireWire Audio Console in one of two ways:

- Quit Cubase, and then run the MOTU FireWire Audio Console from the Finder, OR
- Temporarily switch to a different ASIO Device in the System dialog, and then run the MOTU FireWire Audio Console from the Finder.

In either case, any changes you make to the MOTU FireWire Audio Console window will be reflected in Cubase when you reactivate the MOTU FireWire ASIO driver in Cubase.

**NUMBER OF CHANNELS**

In Cubase, be sure to choose enough channels in the System dialog (as shown above in Figure 10-3) to cover the 18 channels of input and 22 channels of output provided by your 896HD — although the number of channels may depend on how your 896HD is configured:

- 12 channels for analog I/O (including the headphone out)
- 2 channels for AES/EBU
- Zero or 8 channels for optical, depending on whether you have optical turned off or set to ADAT optical

For example, if you are using analog only, the 896HD requires a minimum of 12 channels (for 12 channels of output). If you are using analog and AES/EBU, you need 14 channels.

As another example, if you are using analog, AES/EBU and ADAT optical, you need 22 channels (the maximum number of simultaneous output channels provided by the 896HD).

In Cubase, set the number of channels in the System dialog (as shown above in Figure 10-3).

**ASIO DIRECT MONITORING**

The ASIO Direct Monitoring option (Figure 10-3) allows you to monitor inputs directly in the 896HD hardware with no drain on your computer and near zero latency. When you enable this option, Cubase uses the 896HD's CueMix DSP monitoring features whenever you use Cubase's monitoring...
features. For further information, see “Controlling CueMix DSP from within Cubase or Nuendo” on page 91.

**OTHER SYSTEM DIALOG SETTINGS**

Consult your Cubase or Nuendo documentation for details about the rest of the settings in this dialog.

**ACTIVATING 896HD INPUTS**

Once you’ve chosen the MOTU FireWire ASIO driver in the Audio System dialog as explained earlier in “Choosing the MOTU FireWire ASIO driver” on page 77, choose **VST Inputs** from the Panels menu (or the Devices menu in Cubase SX) to see the 896HD inputs. To activate them, click the Active light next to each input. If you don’t see the optical inputs and/or outputs, check the MOTU FireWire Audio Console to make sure they are turned on and set to the format you require. If you don’t plan to use the optical input or output, turn it off to conserve computer bandwidth.

The “Mix1 1-2” input

In Cubase’s VST Inputs window, you’ll see an 896HD input called **Mix1 1-2**. This input source delivers the output of CueMix DSP “MIX1” (the first mix bus of the four on-board no-latency monitor mixes in the 896HD) to your computer. This input serves, for example, as a convenient way for you to record the 896HD’s MIX1 monitor mix into Cubase (for reference and archiving purposes). Further, if you are sending audio from Cubase to the same output pair as MIX1, you can choose to either include or exclude the audio from the computer in the Mix1 stream being sent to Cubase. For details on how to do this, see “Mix1 Return Includes Computer” on page 96.

The Mix1 1-2 input is not available at the 4x sample rates (176.4 or 192kHz).

⚠️ **Warning:** the Mix1 1-2 input can cause feedback loops! DO NOT assign this input to a track that shares the same 896HD output pair as MIX1.

![Figure 10-4: Activating 896HD inputs in Cubase VST.](image)
ASSIGNING INPUTS
Once you’ve activated the 896HD inputs as shown in the previous section, you can then assign them to Cubase or Nuendo audio channels in the channel mixers in the usual fashion.

TRIMMING THE ANALOG INPUTS
The 896HD analog inputs provide trim knobs on the front panel. To calibrate an audio input, feed signal to the input, and adjust the input’s corresponding trim knob on the front panel of the 896HD until peaks in the level meter are as high as possible without clipping (hitting zero dB).
ASSIGNING OUTPUTS
Once you’ve chosen the MOTU FireWire ASIO driver in the Audio System dialog as explained earlier in “Choosing the MOTU FireWire ASIO driver” on page 77, 896HD outputs will be available in Cubase or Nuendo as output destinations. In Cubase VST, these outputs appear in the VST Master Mixer window as output assignments for the master fader and busses, as shown below in Figure 10-7. In Nuendo, they appear in the VST Outputs window.

In Cubase VST, use the output buttons at the bottom of each channel strip, including the master fader, to assign 896HD outputs to busses. You can then assign channels in the VST Master Mixer window to each bus as desired.

In Nuendo, access the 896HD outputs via the busses in the VST Outputs window.

Figure 10-7: Working with 896HD outputs in Nuendo or Cubase.
The “Phones 1-2” output
If you’ve chosen to treat the 896HD headphones as an independent output, you’ll see Phones 1-2 as an 896HD output destination. Audio tracks assigned to this output pair will be heard on the headphone jack only. For further explanation, see “Phones” on page 77.

CHANGING 896HD SETTINGS
To change the 896HD settings at any time, run the MOTU FireWire Audio Console. See “The ASIO Control Panel button” on page 78 for details. In Nuendo, go to the Device Setup window and click the ASIO Control Panel button, as shown in Figure 10-3 on page 78.

PROCESSING LIVE INPUTS WITH PLUG-INS
If you patch a live input (such as a MIDI synthesizer) through a VST plug-in effect in Cubase, you might hear a slight delay. There are several ways to reduce this delay. For details, see chapter 11, “Reducing Monitoring Latency” (page 85).

SYNCHRONIZATION
Cubase or Nuendo can run under its own transport control or slave to SMPTE time code. It can also perform sample-accurate digital audio transfers with Alesis digital recorders and Tascam family digital recorders.

As you read through the following sections to decide what form of synchronization you might need with other devices in your studio, be sure to consult chapter 3, “Installing the 896HD Hardware” (page 15) for the proper hardware connections. Use the synchronization diagrams in that chapter to be clear about how you will be synchronizing Cubase to the other components of your system.

Running Cubase or Nuendo under its own transport control
If you do not need to synchronize Cubase or Nuendo with time code or another recording device, such as a tape deck, just leave its SMPTE time code synchronization features disabled.

However, even though Cubase or Nuendo is not slaving to SMPTE time code, you still need to be concerned with the synchronization of the 896HD’s digital audio clock with other devices connected to it digitally (if any). For example, if you have a digital mixer connected to an 896HD interface via an ADAT optical lightpipe cable, you need to make sure that their audio clocks are phase-locked. For details, see “Syncing optical devices” on page 25 and “Making sync connections” on page 19. If you don’t have any digital audio devices connected, digital audio phase-lock does not apply to you.

Resolving Cubase or Nuendo and the 896HD to word clock, video and/or SMPTE time code
To resolve your 896HD to word clock, video and/or SMPTE time code using an additional synchronization device, use the setup shown in “Syncing word clock devices” on page 29 or “Syncing to video and/or SMPTE time code” on page 24.

Follow the instructions in your Cubase or Nuendo manual for slaving them to MIDI Time Code (MTC). To ensure that your audio tracks don’t drift out of sync with your MIDI tracks — or time code, use a hardware synchronizer like the MIDI Timepiece AV or Digital Timepiece to resolve the 896HD hardware as well, as explained in “Syncing to video and/or SMPTE time code” on page 24. A digital audio synchronizer is required for drift-free SMPTE/MIDI time code sync. Make sure the Clock Source setting in the MOTU FireWire Audio Console window has the appropriate setting for locking the 896HD to the synchronizer. For
example, in Figure 3-12 on page 24, word clock is being used to resolve an 896HD interface, so the Clock Source setting is Word Clock In.

If you have an ADAT sync or a Tascam sync compatible device, don’t use SMPTE time code. Instead, use sample-accurate sync as described in the next section.

**Sample-accurate sync to ADAT or Tascam**

Cubase and Nuendo, along with the 896HD and its ASIO 2 driver, provide you with sample-accurate transfers with ADATs, Alesis recorders and any other devices that support standard ADAT sample address (ADAT Sync).

Similarly, with the help of a MOTU Digital Timepiece universal A/V synchronizer, Cubase (or Nuendo) and an 896HD can perform sample-accurate transfers with Tascam digital recorders.

A sample-accurate transfer is one in which the original location of the audio is preserved in the transfer, down to the sample.

For details on how to connect your hardware for sample-accurate sync, see “Sample-accurate sync” on page 21. Then, set up Cubase as follows:

Before you begin, in Cubase’s MIDI System Setup window, set OMS compatibility to No OMS. Cubase does not appear to be able to achieve sample-accurate sync when running under OMS.

1. Choose ADAT 9-pin as the Audio Clock Source setting. In Cubase VST, this setting is in the Audio System Setup window (Audio menu). In Nuendo, this setting is in the Device Setup window (Options menu).

2. Go to Cubase or Nuendo’s Synchronization window, as shown below:

   ![Synchronization window](image)

   **Figure 10-8: Setting up sample-accurate sync via ASIO 2.**

3. If you are not using an MMC-compatible synchronizer (such as a MOTU MIDI Timepiece AV, Digital Timepiece or Alesis BRC), choose the settings shown above in Figure 10-8 that applies to you. In this scenario, transport control is handled by the ADAT (or other sample-accurate sync source).

4. If you are using an MMC-compatible synchronizer (such as a MOTU MIDI Timepiece AV, Digital Timepiece or Alesis BRC), set Cubase VST’s Sync Source Timecode Base to ASIO 2.0 MMC or enable Nuendo’s MIDI Machine Control option. In addition, choose the appropriate MIDI port for the MMC synchronizer from VST’s Output menu or Nuendo’s MIDI machine Control MIDI Output menu. If you’re using a MIDI Timepiece AV, you can choose any of its MIDI ports in this menu. Doing so makes Cubase or Nuendo send the MMC control messages to the...
MTP AV (or other MMC device). In this scenario, transport control is handled by Cubase or Nuendo itself.

5. In Cubase VST’s Controls window, enable SYNC. In Nuendo, enable (check) the Sync Online command in the Transport menu.

6. Begin playback from the sample-accurate sync source (ADAT, DA-88, etc.). Transport control is handled by the sample-accurate sync source.

**MIDI MACHINE CONTROL (MMC)**

If you have ADATs (or other ADAT Sync-compatible recorders) and a MMC-compatible ADAT synchronizer like the MIDI Timepiece AV and Digital Timepiece, you can control everything from your computer screen with Cubase’s transport controls and cueing features (like the playback wiper, etc.).

Similarly, if you have Tascam digital recorders and a MOTU Digital Timepiece (or other MMC-compatible Tascam synchronizer), you can control all of your Tascam tape decks (in ABS time) in a similar fashion from Cubase.

See “Sample-accurate sync to ADAT or Tascam” on page 83 for details on how to set this up.

**USING A FOOT SWITCH**

Use a foot switch connected to the 896HD to trigger recording punch-in and punch-out, or any other feature in your host audio software that is assigned to a computer keystroke. By default, the foot switch triggers the 3 key on the computer keypad. To trigger a different set of keystrokes with the foot switch, visit the MOTU FireWire Audio Console. (See “Enable Pedal” on page 43.)

**24-BIT OPERATION**

Your 896HD hardware fully supports Cubase and Nuendo’s 24-bit recording capabilities. Simply enable 24-bit operation as instructed in your Cubase or Nuendo manual. The 896HD always supplies a 24-bit data stream, and when you enable 24-bit operation in Cubase or Nuendo, it simply uses all 24-bits supplied by the 896HD hardware.

**MONITORING SYSTEM PERFORMANCE**

Because it has so many inputs and outputs, the 896HD may push the limits of your computer’s processing power. Keep the VST Performance window open to keep tabs on the load on your CPU and disk buffers. If the meters get too high, you can reduce the load by reducing the number of inputs and outputs you are working with. Use the MOTU FireWire Audio Console to uncheck input check boxes and set output source menus to None.
CHAPTER 11 Reducing Monitoring Latency

OVERVIEW

Monitoring latency is that slight delay you hear when you run an input signal through your host audio software. For example, you might hear it when you drive a live mic input signal through a reverb plug-in running in your audio sequencer.

This delay is caused by the amount of time it takes for audio to make the entire round trip through your computer, from when it first enters an 896HD input, passes through the 896HD hardware into the computer, through your host audio software, and then back out to an 896HD output.

If you don’t need to process a live input with plug-ins, the easiest way to avoid monitoring latency is to use the 896HD’s CueMix DSP feature to patch the input directly to your monitor outs via the 896HD audio hardware. This is just like bussing inputs to outputs in a digital mixer. For details, see “CueMix DSP hardware monitoring” on page 89.

If you do need to process a live input with plug-ins, or if you are playing virtual instruments live through your 896HD audio hardware, you can significantly reduce latency — and even make it completely inaudible, regardless of what host audio application software you use. This chapter explains how.

It is important to note that monitoring delay has no effect on when audio data is recorded to disk or played back from disk. Actual recording and playback is extremely precise.
MONITORING LIVE INPUT
There are two ways to monitor live audio input with an 896HD: 1) through the computer or 2) via CueMix™ DSP hardware monitoring. Figure 11-1 on page 86 shows method 1, which allows you to add effects processing such as reverb and guitar amp effects via plug-ins in your audio software. See the next section, “Adjusting the audio I/O buffer” for details about how to reduce — and possibly eliminate — the audible monitoring delay that the computer introduces.

Figure 11-2 shows how to use CueMix™ DSP hardware-based monitoring, which lets you hear what you are recording with no monitoring delay and no computer-based effects processing. (You can add effects later, after you’ve recorded the live input as a disk track.) See “CueMix DSP hardware monitoring” later in this chapter for details on how to use CueMix DSP with your audio software, or with the included CueMix Console software.

If the material you are recording is suitable, there is a third way to monitor live input: use both methods (Figure 11-1 and Figure 11-2) at the same time. For example, you could route vocals to both the

---

Figure 11-1: There are two ways to monitor live audio inputs with an 896HD: 1) through the computer or 2) via CueMix™ DSP hardware monitoring. This diagram shows method 1 (through the computer). When using this method, use your host software’s buffer setting (or, under Mac OS 9, the 896HD’s ‘Samples Per Buffer’ setting in the MOTU FireWire Audio Console) to reduce the slight delay you hear when monitoring the live input, but don’t lower it too much, or your computer might get sluggish.
computer (for a bit of reverb) and mix that processed signal on the main outs with dry vocals from CueMix DSP.

ADJUSTING THE AUDIO I/O BUFFER

A buffer is a small amount of computer memory used to hold data. For audio interfaces like the 896HD, buffers are used for the process of transferring audio data in and out of the computer. The size of the buffers determines how much delay you hear when monitoring live inputs through your audio software: larger buffers produce more delay; smaller buffers produce less.

Adjusting buffer settings under Mac OS X

Under Mac OS X, audio I/O buffer size is handled by the host audio application (not the 896HD CoreAudio driver). Most audio software applications provide an adjustable audio buffer setting that lets you control the amount of delay you'll hear when monitoring live inputs or processing them with software plug-ins. Below are a few examples.

Figure 11-3: In Digital Performer and AudioDesk, choose Setup menu>Configure Audio System>Configure Hardware Driver to open the dialog shown above and access the Buffer Size setting. Refer to your Digital Performer or AudioDesk manual for information about the Host Buffer Multiplier setting.

Figure 11-2: This diagram shows the signal flow when using CueMix™ DSP no-latency monitoring. Notice that this method does not allow you to process the live input with plug-ins in your audio software while it is being monitored. You can, however, add effects later — after recording the live input as a disk track. CueMix™ DSP lets you hear what you are recording with no delay and no computer-based effects.

1. Live input (from mic, guitar, etc.) enters the MOTU interface.

2. CueMix™ DSP immediately patches the live mic signal directly to the main outs (or other output), completely bypassing the computer (dry, with no effects processing).

3. Mic signal is mixed with the main outs, and you can control the volume (relative to the rest of the mix) with the mic's fader in CueMix Console.
REDUCING MONITORING LATENCY

Figure 11-4: In Cubase SX or Nuendo, choose Devices menu > Device Setup and click VST Multitrack to access the window above and the Audio Buffer Size setting.

Figure 11-5: In Logic Audio, go to the Audio Driver preferences to access the I/O Buffer Size option shown above.

Adjusting the buffer setting under Mac OS 9
Under Mac OS 9, audio I/O buffer size adjustment is made in the MOTU FireWire Audio Console, as shown in Figure 11-6 via the Samples Per Buffer setting.

Figure 11-6: Lowering the ‘Samples Per Buffer’ setting in the MOTU FireWire Audio Console Window reduces patch thru latency. But doing so increases the processing load on your computer, so keep an eye on the Performance Monitor window in AudioDesk (or similar feature in your host audio software).

Lower latency versus higher CPU overhead
The buffer setting has a large impact on the following things:

- Patch thru latency
- The load on your computer’s CPU
- Possible distortion at the smallest settings
- How responsive the transport controls are in AudioDesk, Digital Performer or other audio software

The buffer setting presents you with a trade-off between the processing power of your computer and the delay of live audio as it is being patched through your software. If you reduce the size, you reduce patch thru latency, but significantly increase the overall processing load on your computer, leaving less CPU bandwidth for things like real-time effects processing. On the other hand, if you
increase the buffer size, you reduce the load on your computer, freeing up bandwidth for effects, mixing and other real-time operations.

Figure 11-7: When adjusting the buffer size to reduce monitoring latency, watch the ‘processor’ meter in Digital Performer or AudioDesk’s Performance Monitor. If you hear distortion, or if the Performance meter is peaking, try raising the buffer size.

If you are at a point in your recording project where you are not currently working with live, patched-thru material (e.g., you’re not recording vocals), or if you have a way of externally processing inputs, choose a higher buffer size. Depending on your computer’s CPU speed, you might find that settings in the middle work best (256 to 1024).

Transport responsiveness
Buffer size also impacts how quickly your audio software will respond when you begin playback, although not by amounts that are very noticeable. Lowering the buffer size will make your software respond faster; raising the buffer size will make it a little bit slower, but barely enough to notice.

Effects processing and automated mixing
Reducing latency with the buffer size setting has another benefit: it lets you route live inputs through the real-time effects processing and mix automation of your audio software.

CUEMIX DSP HARDWARE MONITORING
The 896HD has a more direct method of patching audio through the system. This method is called CUEMIX DSP. When enabled, CUEMIX DSP activates hardware patch-thru in the 896HD itself. CUEMIX DSP has two important benefits:

- First, it completely eliminates the patch thru delay (reducing it to a small number of samples — about the same amount as one of today’s digital mixers).
- Secondly, CUEMIX DSP imposes no strain on the computer.

The trade-off, however, is that CUEMIX DSP bypasses your host audio software. Instead, live audio inputs are patched directly through to outputs in the 896HD itself and are mixed with disk tracks playing back from your audio software. This means that you cannot apply plug-ins, mix automation, or other real-time effects that your audio software provides. But for inputs that don’t need these types of features, CUEMIX DSP is the way to go.

On the other hand, if you really need to use the mixing and processing provided by your audio software, you should not use CUEMIX DSP. Instead, reduce latency with the buffer setting (as explained earlier in this chapter).

TWO METHODS FOR CONTROLLING CUEMIX DSP
There are two ways to control CUEMIX DSP:

- With CUEMIX Console
- From within your host audio software (if it supports direct hardware monitoring)

You can even use both methods simultaneously.

Using CUEMIX Console
If your host audio software does not support direct hardware monitoring, you run CUEMIX Console side-by-side with your audio software and manage your monitor mix in CUEMIX Console.

CUEMIX Console allows you to create up to four separate 896HD monitor mixes, or any other desired routing configurations. These routings are
independent of your host audio software. For complete details, see chapter 12, “CueMix Console” (page 93).

Controlling CueMix DSP from your audio software
Some audio applications allow you to control CueMix DSP monitoring from within the application (without the need to use CueMix Console). In most cases, this support consists of patching an 896HD input directly to an output when you record-arm a track. Exactly how this is handled depends on the application.

The following applications are among those that support direct control over CueMix DSP:

- Digital Performer (Mac OS 9 and X)
- AudioDesk (Mac OS 9 and X)
- ASIO-compatible audio software (Mac OS 9)

CueMix DSP routings that are made via host applications are made “under the hood”, which means that you won’t see them in CueMix Console. However, CueMix DSP connections made inside your host audio software dovetail with any other mixes you’ve set up in CueMix Console. For example, if your host application routes audio to an output pair that is already being used in CueMix Console for an entirely separate mix bus, both audio streams will simply be merged to the output.

Follow the directions below in the section that applies to you.

Controlling CueMix DSP from within AudioDesk or Digital Performer
To turn on CueMix DSP in AudioDesk and Digital Performer:

1. From the Setup menu (Basics menu under OS 9), choose MOTU Audio System options>Input Monitoring Mode.

2. Choose the Direct hardware playthrough option, as shown below in Figure 11-8.

3. From the Studio menu (Windows menu under OS 9), choose Audio Monitor, and enable Audio Patch Thru (the button with the headphone icon on it).

Once enabled, CueMix DSP monitoring is tied with Digital Performer or AudioDesk’s Audio Patch Thru feature: when you record-enable a track, the track’s input is routed directly to its output (via CueMix DSP in the 896HD hardware). For example, if you record-enable a track called guitar in your DP or AudioDesk project, and its audio input assignment is Analog in 2, and its audio output assignment is optical channels 7-8, CueMix DSP no-latency hardware monitoring will automatically be set up from Analog in 2 to optical outputs 7-8.

Note to 828 or 896 users who have upgraded to an 896HD: notice that the Auto CueMix Update check box has been removed as a result of the 896HD’s more flexible and powerful CueMix DSP features. Auto CueMix Update is no longer needed.
because you enjoy the benefits of CueMix DSP patch thru, plus separate, independent mixing under CueMix Console, thanks to the much more powerful CueMix DSP engine.

Using CueMix with Sound Manager (Mac OS 9 only)

To enable CueMix DSP for a host application that is using the MOTU FireWire Sound Manager driver:

1. Open the Sound Control Panel, click the Input tab, and check the Play sound through output device option. Alternately, you can use the CueMix Console (described in chapter 12, “CueMix Console” (page 93)) to manually patch a live input to an output.

2. To control the overall level of the CueMix input, use the CueMix Console.

Controlling CueMix DSP from within Cubase or Nuendo

To turn on CueMix in Cubase VST, enable the ASIO Direct Monitor check box in the Monitoring section of the Audio System Setup window (Figure 10-3 on page 78). In Cubase SX or Nuendo, enable the Direct Monitoring check box in the Device Setup VST Multitrack tab (Figure 11-4 on page 88).

Other ASIO 2.0-compatible host software

If your ASIO-compatible host audio software supports ASIO’s direct monitoring feature, consult your software documentation to learn how to enable this feature. Once enabled, it should work similarly as described for Cubase (as explained in the previous section).
CHAPTER 12  CueMix Console

OVERVIEW
CueMix Console provides access to the flexible on-board mixing features of the 896HD. CueMix lets you route any combination of inputs to any stereo output pair. These mixes can be set up entirely independently of your host audio software. CueMix allows you to set up four completely independent mix configurations with the 896HD. You can also save and load mix configurations.

CueMix Console can be used independently of host audio software, or together with it. CueMix mixing dovetails with the direct monitoring (hardware patch thru) features of your host audio software, allowing you to seemlessly mix in both environments. CueMix Console can also be controlled from automated hardware control surfaces such as the Mackie Control™.

Figure 12-1: CueMix Console is a virtual mixer that gives you control over the 896HD’s on-board mixing features.
ADVANTAGES OF CUEMIX MONITORING
CueMix Console provides several major advantages over monitoring live inputs through your host audio software:

- CueMix has no buffer latency. Thanks to the 896HD's DSP chip, CueMix provides the same throughput performance as a digital mixer.
- CueMix imposes absolutely no processor drain on the computer's CPU.
- CueMix routing can be maintained independently of individual software applications or projects.
- CueMix routing can operate without the computer, allowing the 896HD to operate as a portable, stand-alone mixer.

CueMix Console does not provide effects processing. For information about using your audio software's native plug-ins together with CueMix, see chapter 11, “Reducing Monitoring Latency” (page 85).

CUEMIX CONSOLE INSTALLATION
CueMix Console is installed with the rest of your 896HD software.

CUEMIX CONSOLE BASIC OPERATION
The CueMix console is simple to operate, once you understand these basic concepts.

Four mixes
CueMix provides four separate mixes: Mix1, Mix2, Mix3 and Mix4. Each mix can have any number of inputs mixed down to any 896HD output pair that you choose. For example, Mix1 could go to the headphones, Mix2 could go to the main outs, Mix3 could go to a piece of outboard gear connected to analog outputs 7-8, etc.

At the 4x samples rates (176.4 and 192kHz), CueMix DSP supports only two independent monitor mixes, due to the extremely high bandwidth demands of these sample rates.

Many inputs to one output pair
It might be useful to think of each mix as some number of inputs all mixed down to a stereo output pair. CueMix Console lets you choose which inputs to include in the mix, and it lets you specify the level and pan for each input being fed into the mix.

Viewing one mix at a time
CueMix Console displays one mix at a time. To select which mix you are viewing, click its tab at the bottom of the window, as shown in Figure 12-1. The mix name appears in the tab. Double-click the name to change it.

Each mix is completely independent
Each mix has its own settings. Settings in one mix will not affect another. For example, if an input is used in one mix, it will still be available in other mixes. In addition, inputs can have a different volume, pan, mute and solo setting in each mix.

Widening the CueMix Console window
To view more input faders at once, drag the grow box (Figure 12-1) to the right.

WORKING WITH A MIX
Each mix has the following components:

- A stereo output with master fader
- Name
- Master mute (to enable/disable the entire mix)
- Any number of mono or stereo inputs
- Pan, volume, mute and solo for each input

These elements are visually grouped together in the lightly shaded area in the lower half of the CueMix Console window.
 Viewing a mix
To view a mix, click its tab at the bottom of the window, as shown in Figure 12-1. The mix name appears in the tab.

 Naming a mix
Double-click the mix name in the tab.

 Master mute
The master mute button (Figure 12-1) temporarily disables (silences) the mix.

 Master fader
The master fader (Figure 12-1) controls the overall level of the mix (its volume on its stereo output). Use the individual input faders to the left to control individual input levels.

 Adjusting master faders from the front panel
You can adjust the master fader level for each mix using the MONITOR LEVEL knob on the 896HD front panel. When you turn it, the analog input meters (channels 1-4) temporarily display the current volume setting for each mix. A few seconds after you stop turning (or pushing) the knob, the meters revert back to displaying analog input levels.

 The MONITOR LEVEL knob controls each CueMix master fader as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push the knob</td>
<td>To view the current fader levels for all four CueMix busses.</td>
</tr>
<tr>
<td>Turn the knob</td>
<td>To adjust the currently selected fader. (This is indicated by a flashing red “over” LED at the top of the meter.)</td>
</tr>
<tr>
<td>Push the knob again</td>
<td>To cycle to the next mix bus. The flashing red “over” LED shows you which bus you are adjusting.</td>
</tr>
</tbody>
</table>

 When using the MONITOR LEVEL knob to view and modify the CueMix master fader levels, the 8-channel bank of programmable meters (to the right of the analog input meters) displays the output level for each mix bus as follows:

<table>
<thead>
<tr>
<th>Programmable meter channels</th>
<th>Mix bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-2</td>
<td>Mix1</td>
</tr>
<tr>
<td>3-4</td>
<td>Mix2</td>
</tr>
<tr>
<td>5-6</td>
<td>Mix3</td>
</tr>
<tr>
<td>7-8</td>
<td>Mix4</td>
</tr>
</tbody>
</table>

 Output level meters
The OUT level meters show you the output for the mix’s physical output, which may include audio from your host audio software. The clip indicators clear themselves after a few seconds.

 Input section
The channel strips to the left of the master fader represent each input in your 896HD. Use the input scroll bar to view additional inputs.

 Input mute/solo
To add an input to a mix, or remove it, click its MUTE button. To solo it, use its SOLO button. To toggle these buttons for a stereo pair, hold down the command key while clicking either channel. The Solo indicator LED (Figure 12-1) lights up when any input is soloed (including inputs that may currently be scrolled off-screen).

 Input volume and pan
Use the input fader and pan knob (Figure 12-1) to adjust these settings for the input in the mix. Again, all settings within the gray-shaded channel strip area belong to the mix currently being viewed. Note that an input can have different settings in different mixes.

 To adjust the volume or panning for a stereo input pair, hold down the command key while dragging the fader or knob for either the left or right input.
SHORTCUTS
Hold down the following modifier keys as shortcuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift key</td>
<td>Applies your action to all inputs in the mix.</td>
</tr>
<tr>
<td>Command key</td>
<td>Applies your action to the stereo input pair</td>
</tr>
<tr>
<td>Option key</td>
<td>Applies your action to all busses</td>
</tr>
<tr>
<td>Double-click</td>
<td>Returns the control to its default value (pan center, unity gain, etc.)</td>
</tr>
</tbody>
</table>

COPYING & PASTING (DUPLICATING) ENTIRE MIXES
To copy and paste the settings from one mix to another:

1. Select the source mix (Figure 12-1) and choose Copy from the file menu (or press command-C).
2. Choose the destination mix and choose Paste from the file menu (or press command-V).

MESSAGE CENTER
The Message Center displays fly-over help for items in the CueMix Console window. It also displays messages regarding the overall operation of the 896HD.

FILE MENU
The CueMix Console File menu has the following items.

Save Preset / Load Preset
The 896HD can store up to 16 presets in its onboard memory. A preset includes all CueMix DSP settings for all mix busses, but it excludes global settings like clock source and sample rate.

The Load Preset and Save Preset commands in the CueMix Console file menu let you name, save and load presets in the 896HD hardware.

Save / Load
The Save and Load commands in the CueMix Console File menu allow you to save 896HD presets to and from your hard drive. This allows you to save an unlimited number of 896HD presets on disk. (Use the Load Preset and Save Preset commands to get presets from — and save them to — the 896HD itself.) Choose Save to save the current configuration; choose Load to open an existing configuration that you have previously saved to disk.

Edit Channel Names
The Edit Channel Names command in the File menu lets you change generic 896HD input and output names (e.g. “Analog 1”, “Analog 2”, etc.) to more descriptive names like “snare mic” and “reverb return”. This menu command provides access to the same channel naming window as the Edit Channel Names button in the MOTU FireWire Console window General tab. For complete details about naming channels, see “Edit Channel Names” on page 43.

Mix1 Return Includes Computer
The Mix1 return includes computer item in the CueMix Console File menu refers to the Mix1 bus that the 896HD driver provides as an input to host audio software. This input source delivers the output of CueMix DSP “MIX1” (the first mix bus of the four on-board no-latency monitor mixes in the 896HD) back to your computer. This input serves, for example, as a convenient way for you to record the 896HD’s MIX1 monitor mix back into your host audio software (for reference and archiving purposes).

When the Mix1 return includes computer menu item is checked, any audio being sent from your audio software on the computer to the same output as Mix1 will be included in the Mix1 return bus. When it is unchecked, computer output is excluded.
This menu item is essentially a pre/post switch for the computer audio insert to the stream of audio going to Mix1’s 896HD output pair (and also back to the computer).

**Show meter in dock icon (Mac OS X only)**

This CueMix Console File menu item, when checked, causes the CueMix Console dock icon to display a small level meter that mirrors the main output meter for the current mix being displayed in CueMix Console.

**EDIT MENU**

The commands in the Edit menu let you copy and paste entire mix bus settings. See “Copying & pasting (duplicating) entire mixes” on page 96.

**PHONES MENU**

The Phones menu allows you to choose what you will hear on the headphone output, just like the Phones setting the MOTU FireWire Audio Console. However, this menu provides one extra option that is exclusive to CueMix Console: **Follow Active Mix**. This menu item, when checked, causes the headphone output to mirror the output of the current mix being viewed in CueMix Console. For example, if you are currently viewing Mix3 (the Mix3 tab is active), the headphones will mirror the Mix3 output (whatever it is assigned to).

**CONTROL SURFACES MENU**

CueMix Console can be controlled from an automated control surface such as the Mackie Control™. Use the commands in the Control Surfaces menu to enable and configure this feature.

**Application follows control surface**

When checked, the **Application follows control surface** menu command makes the CueMix Console window scroll to the channel you are currently adjusting with the control surface, if the channel is not visible when you begin adjusting it. The same is true for the bus tabs: if you adjust a control in a bus that is not currently being displayed, CueMix Console will jump to the appropriate tab to display the control you are adjusting.

**Share surfaces with other applications**

When the **Share surfaces with other applications** menu command is checked, CueMix Console releases the control surface when you switch to another application. This allows you to control your other software with the control surface. Here’s a simple way to understand this mode: the control surface will always control the front-most application. Just bring the desired application to the front (make it the active application), and your control surface will control it. When you’d like to make changes to CueMix Console from the control surface, just bring CueMix Console to the front (make it the active application).

When this menu item is unchecked, your control surface will affect CueMix Console all the time, even when CueMix Console is not the front-most application. In addition, you will not be able to control other host audio software with the control surface at any time (because CueMix Console retains control over it at all times). This mode is useful when you do not need to use the control surface with any other software.

**Mackie Control Surfaces**

CueMix Console includes support for the following control surface products:

- Mackie Control™
- Mackie HUI™
- Mackie Baby HUI™

Use the sub-menu commands in the **Mackie Control Surfaces** menu item to turn on and configure control surface support, as described briefly below.
Enabled
Check this menu item to turn on control surface operation of CueMix Console. Uncheck it to turn off control surface support.

Configure…
Choose this menu item to configure your control surface product. Launch the on-line help for specific, detailed instructions for configuring CueMix Console for operation with your control surface product.

Radikal Technologies SAC-2.2
The Radikal Technologies SAC-2.2 can be used via its HUI emulation mode. Just put the SAC-2.2 hardware into HUI emulation mode, and then follow the CueMix Console on-line help instructions (Figure 12-2) for HUI operation. Consult the SAC-2.2 manual for details about how put it into HUI emulation mode.

Other HUI-compatible control surfaces
Any control surface that has the ability to emulate a HUI should be compatible with CueMix Console. Just put the control surface hardware into HUI emulation mode, and then follow the CueMix Console on-line help instructions (Figure 12-2) for HUI operation. Consult the manual for the control surface for details about how put it into HUI emulation mode.

Other control surface hardware products
If you install other control surface drivers written for CueMix Console, they will appear as separate menu items at the bottom of the Control Surfaces menu, with the same sub-menu items described above.

Figure 12-2: Refer to the extensive on-line help for details about configuring CueMix Console for operation with your control surface product.
STAND-ALONE OPERATION
All settings, including all mix settings and global settings, are saved in the 896HD’s memory, and they remain in effect even when the 896HD is not connected to a computer. This allows you to use the 896HD as a stand-alone 8-bus mixer. You can make adjustments to the four mix bus master faders at any time from the front panel.

CUEMIX CONSOLE EXAMPLES
Figure 12-3 shows some examples of how you can use CueMix DSP:

- Powered speakers are connected to the 896HD main outs. Any input can be routed directly to the speakers.
- Microphone input can be routed via CueMix DSP to the effects processor for live outboard processing during recording. The resulting signal can be recorded into the computer either wet, dry or both (via the effects processor return or the direct mic input).
- The ADAT optical connection provides 8 channels of 24-bit digital I/O to the digital mixer (or 4 channels at 96kHz). Any device connected to the 896HD can be routed to/from the mixer with no latency. Conversely, any mixer channel can be routed to any device connected to the 896HD with no latency.
- Another example of ADAT optical connectivity is to use Giga Studio, and use CueMix DSP to route Giga inputs directly to the powered monitors connected to the 896HD for no-latency monitoring of your Giga tracks.
CHAPTER 13  Troubleshooting

Using Pro Tools, Sound Manager and -50 error (OS 9 only)
When using Sound Manager, Pro Tools software will only allow audio input via the Macintosh’s Built-in hardware. Therefore, you cannot use the 896HD as the input device to Pro Tools software. If the 896HD driver is selected as the input device in the Sound Control Panel, Pro Tools will return a -50 error and not launch. You can, however, select Built-in as the input device and the 896HD as the output device in the Sound Control Panel. After doing so, you can run Pro Tools and monitor your output through the MOTU 896HD.

Sample accurate sync in AudioDesk and Digital Performer
When you first use sample accurate sync, be sure to go to the Receive Sync dialog in Digital Performer or AudioDesk and switch from “MTC” to “Sample-accurate.”

Cubase - MOTU 896HD inputs and outputs are not visible in Cubase
You probably need to enable them in Cubase.

Can't authenticate AudioDesk
When installing software off the CD-ROM, the OK button does not become active until you have entered in your name and a valid keycode. Your name must contain at least 3 characters, and you must enter the keycode exactly as it appears in your AudioDesk manual (on the inside of the back cover).

MOTU FireWire Audio Console or Control Strip module settings are grayed out for no reason
Some settings cannot be accessed while the 896HD is active. Quit all audio software that uses the 896HD (including any Sound Manager applications, if any), and then the 896HD settings should no longer be grayed out.

No input on an ADAT tape deck
If you are having trouble recording on your ADAT tape deck from the 896HD, check the Digital input setting. After power cycling, tape decks often come up configured to record from their analog inputs. You won't be able to record from the 896HD to a tape deck until it is switched to digital input. Tip: configure this in ClockWorks or AudioDesk if you want your decks to come up in the right mode when power cycled.

Clicks and pops under word clock sync
Many problems result from incorrect word clocking. It is essential that all digital devices in the system be word locked. Consult “Making sync connections” on page 19 for detailed information on how to word clock your gear. Whenever there is any weird noise or distortion, suspect incorrect word lock.

Clicks and pops under ADAT Sync
Sometimes, the ADAT sync cable seems to be plugged into the 896HD, and it partially works. But it isn't really all the way in. This can cause clicks when slaved to ADAT 9-pin. Make sure the ADAT Sync cable plug is really seated firmly.

Clicks and pops due to hard drive problems
If you have checked your clock settings and you are still getting clicks and pops in your audio, you may have a drive related problem. Set your Clock Source to Internal and try recording just using the analog inputs and outputs of the 896HD. If you encounter the same artifacts you may want try using another drive in your computer. Clicks and pops can also occur when the drive is severely fragmented, the disk drivers are outdated, or if you are using a SCSI accelerator that is not optimally configured for working with audio.
**Connecting or powering gear during operation**

It is not recommended that you connect/disconnect, or power on/off devices connected to the 896HD while recording or playing back audio. Doing so may cause a brief glitch in the audio.

**No optical inputs or outputs are available in host audio application**

Check to make sure you have the desired optical inputs and/or outputs enabled in the MOTU FireWire Audio Console.

**Monitoring - How to monitor inputs?**

Please refer to the documentation for the audio application that you are using. If your application does not support input monitoring, you will need to use the 896HD’s hardware-based CueMix DSP monitoring feature. Please see chapter 11, “Reducing Monitoring Latency” (page 85).

**Controlling monitoring latency**

See chapter 11, “Reducing Monitoring Latency” (page 85).

**CUSTOMER SUPPORT**

We are happy to provide customer support to our registered users. If you haven’t already done so, please take a moment to complete the registration card included with your 896HD. When we receive your card, you’ll be placed on our mailing list for free software updates and information about new products.

**REPLACING DISKS**

If your 896HD software installer CD becomes damaged and fails to provide you with fresh, working copies of the software, our Customer Support Department will be glad to replace it. You can request a replacement disc by calling our business office at (617) 576-2760 and asking for the customer service department.

**TECHNICAL SUPPORT**

If you are unable, with your dealer’s help, to solve problems you encounter with the 896HD system, you may contact our technical support department in one of the following ways:

- Tech support hotline: (617) 576-3066 (Monday through Friday, 9 am to 6 pm EST)
- Tech support 24-hour fax line: (617) 354-3068
- Tech support email: techsupport@motu.com
- Web site: www.motu.com

Please provide the following information to help us solve your problem as quickly as possible:

- The serial number of the 896HD system. This is printed on a sticker placed on the bottom of the 896HD rack unit. You must be able to supply this number to receive technical support.
- A brief explanation of the problem, including the exact sequence of actions which cause it, and the contents of any error messages which appear on the screen.
- The pages in the manual which refer to the parts of the 896HD or AudioDesk with which you are having trouble.
- The version or creation date of the system software you are using to run the Macintosh.

We’re not able to solve every problem immediately, but a quick call to us may yield a suggestion for a problem which you might otherwise spend hours trying to track down.

If you have features or ideas you would like to see implemented, we’d like to hear from you. Please write to the 896HD Development Team, MOTU Inc., 1280 Massachusetts Avenue, Cambridge, MA 02138.
Analog AES/EBU Meters option

AES/EBU

AES Out x 2 option

AES Out x 2 / AES Out ÷ 2

29

AES Out slave to AES in option

AES Out slave to AES in

42, 50

AES Out ÷ 2 option

AES In option (sample rate conversion)

adjusting bus levels

ADAT sync

ADAT 9-pin

ADAT IN/OUT LEDs

ADAT lightpipe

ADAT IN/OUT LEDs

ADAT sync

ADAT sync sample-accurate 57, 66

adjusting bus levels 5

AES In option (sample rate conversion)

42, 50

AES Out x 2 / AES Out ÷ 2

AES Out x 2 option 42, 50

AES/EBU 6, 10

clock source setting 39, 47

clocking 28

connecting to 16

metering

LED 5

output metering 5

Analog inputs/outputs

trimming in Digital Performer 56,

64, 73, 80

Apple menu 34

Application dock 7

ASIO 35, 75

ASIO 2.0 option 83

MOTU 828 ASIO driver 34

ASIO Control Panel button 37, 45

Audio

bit resolution 38, 46

input/output timing 56, 65

Audio Desk 12, 33, 34, 61

accessing 828 settings 37, 45

MMC control 22

sync settings 22, 23

Balanced analog 16

Buffer Size 48, 55, 63

Calibrating audio input/output 56, 65

Clip Hold Time 7, 42, 50

Clipping 5

Clock 192kHz operation 38

Clock source 7, 19, 39, 46

Audio Desk 63

other audio interfaces 40

Clock status mic input 5

Configure Hardware Driver 37, 45

Configure interface 31

Connecting multiple 896HDs 31

Control Panel (MOTU 828) 34, 37, 45

Control Strip 34

Control Strip module (828) 34, 37, 45

Control surface support 97

Converters 6

CoreAudio defined 33

Cubase

Audio Buffer Size 70

Mac OS X 70

Optical input/output 77

synchronization 82

troubleshooting 101

using a foot switch 73, 84

CueMix Console 89, 93

CueMix DSP 5, 11, 89

output jacks 6

CueMix Plus

output jacks 16

volume control 5

Customer support 102

DAT connecting 17

Default Stereo Input/Output 40

Default stereo Input/Output 7

Digital mixer connecting 18

Digital Performer 12, 53

accessing 828 settings 37, 45

clock source 55, 69, 77

MMC control 22

Optical input/output 55, 63, 70

sample rate 54, 69, 77

sync settings 22, 23

Digital Timepiece 22

Disable check box 49

Disable interface option 32

Disable option 32

Disc replacing 102

Dock 7

Drivers installing USB drivers 33, 34

Edit Channel Names 7

Enable Sound Manager 49

Expansion 31

Feedback loops 56, 64, 72, 79

Fine-tune Audio I/O Timing command 57, 65

FireWire 11

connecting 15

collector 6

Follow Active Mix 97

Foot pedal connecting 17

Foot switch 11, 43, 49

3rd party software 73, 84

Audio Desk 66

configuring 7

connecting 17

Digital Performer 58

jack 5

Force 1x word rate output 30

Force 44.1/48kHz 11

Forget button 32

Front panel 5

General tab 7, 38

Guitar connecting 17

HD192

Word Clock In setting 39, 47

Headphone jack 5, 11

Headphone output 11

Headphones connecting 17

controlling output 41, 49

iMovie
INDEX

audio input/output 40
Input gain 11
Input level meters 5
Inputs
  analog 6
  optical 6
Installation
  hardware 15
  software 34
Installer CD
  replacing, 102
Interface menu
  49
Interface tabs
  7
Internal (sync setting)
  39, 46
iTunes
  audio input/output 40
Latency
  11, 48, 55, 63, 77, 85, 88
Launch console when hardware becomes available 7, 43
LEDs
  11
Level meters
  configuring 42, 50
Lightpipe
  25
Logic Audio
  70
Mac OS X
  input and output names 71
  sound input/output 40
Mackie worksurfaces 97
Main outs
  jacks 6
  making connections to 16
  metering 5
  volume 5
Main volume
  5
Metering
  options 42, 50
Mic inputs
  connecting 17
  phantom power 5
Mic preamps
  10
Mic line inputs
  16
MIDI Machine Control
  20, 21, 58
MIDI Time Code sync 20
MIDI Timepiece AV 22
Mix1 1-2.72
  AudioDesk
  64
  Cubase/Nuendo 79
Digital Performer 56
Mix1 return includes computer 96
Mixing
  using an external mixer 16
MMC
  20, 21, 58
Monitor level
  5
Monitor Level knob
  5
Monitoring
  11, 86
  thru main outs 16
MOTU
  Digital Timepiece 22
  MIDI Timepiece AV 22
MOTU 324 Console 33
MOTU 828
  ASIO driver 35
MOTU 828 Control Panel
  34, 45
MOTU 828 Control Strip module
  7, 34, 37, 45
MOTU Audio System
  bit resolution 38, 46
  fine-tune Audio I/O Timing 57, 65
  input/output timing 56, 65
MOTU FireWire Audio Console
  7, 37
MOTU Folder
  34
MTC sync 20
Neutrik™ connectors 16
Nuendo
  Mac OS X
  optical input/output 77
  synchronization 83
Optical
  connectors 6, 16
  enabling/disabling 41, 49
  overview 10
  sync 25
Optical input/output 7
Optimization
  88
Outputs
  analog 6
  optical 6
  Over LEDs 5
Packing list 13
Patch thru
  latency 48, 88
Peak Hold Time
  7, 42, 51
Pedal
  11, 17, 43, 49
  3rd party software 73, 84
  AudioDesk 66
  configuring 7
  Digital Performer 58
  jack 5
Performance 88
Phantom power 5, 10, 16
Phase-lock 19
Phones
  5, 7, 41, 49, 72
  AudioDesk
  63
  Digital Performer 55, 70, 77
Phones 1-2
  AudioDesk
  64
  Cubase/Nuendo 82
  Digital Performer 56
Phones menu
  97
Power supply
  6
Pro Tools
  101
Problem-solving
  101
Programmable Meters
  7
Programmable meters option 42, 50
Punch in/out 11
Registration 13
Sample rate
  7, 38, 46
  192kHz operation 38
AudioDesk 63
LEDs 5
Sample rate conversion 27
Sample Rate Conversion option 41, 50
Sample rate convert 7
Sample-accurate sync 10, 21, 22, 23, 83
Samplers
  connecting 17
Samples Per Buffer 48, 88
Samples per buffer 48, 55, 63, 77
Show meter in dock icon 97
SMPTE sync 19, 20, 24
Software
  installation 34
  sound control panel
  rate (bit resolution) 38, 46
Sound Manager
  bit resolution 38, 46
  enabling 49
  grayed out 49
  input/output timing 56, 65
Studio setup (example) 17
Sync
  sample-accurate 21, 22, 23
Synchronization 19
  AudioDesk 65
  Cubase 82
  Digital Performer 57
  Nuendo 82
Synths
  connecting 17
System preferences
  sound input/output 40
System requirements
  minimum 13
  recommended computer 12, 13
Technical support 102
Tascam
  Sync 24
Trim (input) 11
Troubleshooting 101
  feedback loop 56, 64, 72, 79
Unbalanced analog 16
USB
  installing drivers 33, 34
Volume
  headphone 11
  Volume knob 11
Video sync 19, 24

104
**W**
- Word clock 11, 19, 24, 29
- 2x or one-half x 30 connectors 6
- sync setting 39, 47
- Word Clock In setting 39, 47
- Word Out 7, 43, 51

**X**
- XLR connectors 16

**Y**
- Yamaha 02R
  - connecting 18
  - Yamaha 02R mixer 25